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Important Note

Please be aware that some modifications and enhancements may require licensing, specific configurations, and setup, and may require involvement of CMiC Consulting in order to be utilized and further training may be required.  Please contact your Account Manager/Project Manager for more information where needed.
Accounts Payable

New AP EFT Format for First Republic Bank ‘FREPUBLBNK’ (21.43534)
New AP EFT Format for First Republic Bank ‘FREPUBLBNK’

Modifications:
Created a new AP EFT format for ‘First Republic Bank’-FREPUBLBNK
Following field values will be used in the file format.
File Header Record
Immediate Destination (321081669)

Immediate Origin (321081669)

Immediate Destination Name (FIRST REPUBLIC BANK)
Batch Header Record
Service Class Code (200)

Company Identification (Company Federal Tax ID from company setup)

Standard Entry Class Code (CCD)
Company Entry Description (PAYMENT)

Originating DFI Identification (32108166)
Entry Detail Record (One details record per vendor)
Transaction Code (22)

Receiving DFI Identification (Bank Transit number from vendor setup)

DFI Account Number (Bank Account number from vendor setup)

Receiving Company Name (Vendor name)

Addenda Record Indicator (1)

Addenda Record (One addenda record for each detail record)
Addenda Type Code (05)

Payment Related Information (List of invoice codes - up to 80 chars max length file limit).
Batch Control Record

Service Class Code (200)

Originating DFI Identification (32108166)
Setup and Printing:
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AP>Setup>Global Tables>EFT Formats
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AP>Check>Print Checks
The following sample EFT file is generated as per the FREPUBLBNK format code:
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New AP EFT Format for CIBC Bank Wire Transfer (21.47984)
Added new EFT format for CIBC Bank Wire Transfer

Modifications:
Created a new AP EFT file format for CIBC bank for WIRE payments. There will be no change in the EFT payment process.

This file will be Comma Delimited file format. There will be no header and trailer record, only detail records.

This will print one single payment line for each vendor on payment selection.

Debit Field Properties Information (Required) -- This section contains the Payer details

ABA / TRC (Bank Account setup - Transit field)

Account Type (C - Checking - will be used)

Account Number (Bank Account setup - Bank Account Number field)

Amount (Total Vendor payment amount)

Send on date (Check date on payment selection)

Currency (Payment currency)

Recipient Field Properties Information (Required) -- This section contains the Payee details

Bank ID type (ABA will be used)

Bank ID (Vendor setup - Accounting Tab - Bank Transit field)

Recipient Account# (Vendor setup - Accounting Tab - Bank Account Number field)

Bank Name (Bank setup - Name field, associated with vendor bank ID field)

Bank Address 1 (Blank as this is optional)

Bank Address 2 (Blank as this is optional)

Bank Address 3 (Blank as this is optional)

Recipient Name (Payee name - BP Name on business partner)

Recipient Address 1 (Vendor setup - Vendor Tab - Street field)

Recipient Address 2 (Vendor setup - Vendor Tab - Suite field)

Recipient Address 3 (Vendor setup - Vendor Tab - City field)

Additional Info for Recipient (Keeping Blank as this is optional)

Wire Initiator Field Properties (Required)

Wire Initiator Name (Since this is same for all records printed on the file so, this field must be defined on AP EFT setup screen)

Wire Initiator Address1 (Since this is same for all records printed on the file so, this field must be defined on AP EFT setup screen)

Wire Initiator Address2 (Since this is same for all records printed on the file so, this field must be defined on AP EFT setup screen)

Wire Initiator Address3 (Since this is same for all records printed on the file so, this field must be defined on AP EFT setup screen)

Note: The following two sections columns are optional, nothing will be printed on this section.

First Intermediary Field Properties Information (Optional)

Second Intermediary Field Properties Information (Optional)
Setup and Printing:
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AP>Setup>Global Tables>EFT Formats
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AP>Check>Print Checks
The following sample EFT file is generated as per the CIBCBNKWIR format code:
[image: image8.png]123456789, C,4850000121,28.41,112921,USD, ABA, 74, 745555558, Bank of Nova Scotia,,,,ARROW,Main St,Suitel9,New York,,,,,
123456789, C,4850000121,839.79,112921,USD, ABA, 01234, 1234567890, KIWI BANK, ,, ,K-Designers,KMCOM,63rd Manhattan,7855,Essex, ,,,,
123456789, C, 4850000121, .76,112921,USD, ABA, 01235, 1234567892, KIWI BANK, ,, ,K-Greens,KMCOM, 55 Avenue,4544,Hudson, , ,,,

123456789, C, 4850000121, 6242..83,112921,USD, ABA, 12356, 1234567894, KIWT BANK, , , ,K-Sunshine,KMCOM,123 Fergusson,1221,Neward, ,,,,
123456789, C, 4850000121, 34.82,112921,USD, ABA, 1234, 485001, KIWT BANK, ,, ,K-Vendor, KNCOM,4011 Streetsville,1206,Jersey City,,,,,
123456789, C, 4850000121, 494.69,112921,USD, ABA, 12356, 1234567895, KIWI BANK, ,, ,K-Wellness,KMCOM, 6@ Toms River,7444,Trenton, ,,,,




New AP Positive Pay File Format for Key Bank (21.50180)
New AP Positive Pay file format for Key Bank- KEYBANK_3
Modifications:
CMiC added a new positive pay format for key bank (KEYBANK_3) that includes payee name.

Setup and Testing:
Create a bank group using the new format code and add bank accounts.
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Create a register by entering the bank group and clicking on [PROCESS]
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A positive pay file is generated as per the specs showing the payee’s name:
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New AP Bank Reconciliation File Format for Scotia Bank (21.51435)
New AP Bank Reconciliation format added - ‘SCOTIABANK ‘

Modifications:

CMIC added a new Bank Reconciliation format for Scotia bank as per the file format "Delimited ASCII Format File Specifications".

Following field values from the file will be used for reconciliation:

Field#6 - Transit & Account Number TTTTTAAAAAAA - Account Number will be read from this column, last 7 digits

Field#25 - Amount - Amount Paid will be read from this column

Field#28 - Value Date (Format: DDMMMYYYY) - Reconciliation Date will be read from this column

Field#32 - Reference Information - Cheque Number will be read from this column

From the file, only TRANSACTION RECORDS will be read for Cheque payments which have the following values for reconciliation:

Field#14 - Debit or Credit Indicator - D = Debit (Only read D type of transactions)

Field#18 - BAI2 Code of the Transaction - 475 (Only read 475 code of transactions)

Field#22 - Mnemonic Code Description - CHQ (Only read CHQ code type of transactions)

Setup and Printing:

Assign the new format ‘SCOTIABANK’ to the bank
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System Data > Global Tables > Banking > Banks

Sample Bank Reconciliation file:
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Process the Bank check Reconciliation
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System Data > Global Tables > Banking > Electronic Reconciliation > Bank Reconciliation
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System Data > Global Tables > Banking > Electronic Reconciliation > Bank Reconciliation

Verify by printing the Bank Reconciliation Report (BA1000)
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COMDATA – Discrete Checks and Payments (22.52492)
AP Check Preparation program prepares discrete checks for a vendor when the AP Invoice flag ‘Discrete Checks’ is set as ‘Y’. Users can now configure the COMDATA settings on their COMDATA account log in in the following two ways. The radio option ‘Create Virtual Card By’ can be set as required by the client’s business requirements. 
1. Create virtual Card By: Supplier Code

a. Setting the option ‘Supplier Code’ will generate PS21 files with the Card Token unique by a Vendor code and hence regardless of discrete checks flag at CMIC, all the payments will be grouped by COMDATA and payment is made as a single payment.
2. Create Virtual Code By: Virtual Card Invoice Number

a. Setting the option as ‘Virtual Card Invoice Number’ will generate PS21 files with discrete token numbers by COMDATA as per the check numbers. The payments from COMDATA will then be discrete for discrete checks and grouped for grouped checks for a vendor.

The PS20 file generated from CMIC now will have the Column 33 populated with full check numbers with 11 characters as generated by CMiC Check preparation program. This column 33 values are used by COMDATA to issue discrete or grouped payments when the radio option in COMDATA configurations is set to ‘Virtual Card Invoice Number’.
The following examples show how the payments are issued by COMDATA based on the configuration settings.
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Comdata Configuration screen for client’s accounts
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Status | Vendor Name Invoice Number | Check# | CheckDate | Amount Paid Response Error
Vald | ATBRICKS | At Bricks Manufacturing Inc. BR7061 14-dan2021 900000 N
Vaid | ATBRICKS | A1 Bricks Manufacturing Inc. BR7062 14-dan2021 35000 N
Vaid | ATMASONS | AtMasons nc s7062 90000002023 | 14-Jan2021 000 | 2zmeaDs | N
Vaid | ATMASONS | AtMasons nc MS7061 0000002023 | 14-Jan-2021 7000 | 2mE3Q7DI | N
Vaid | AIROOF | A1 Roofing Company RE7061 90000002024 | 14-Jan2021 sso0000 | 2mEQT2 | N

Close | | Generate RequestFile| | Import Response File | | Import Reconciliation File | | Delete Check | | Post Checks | | Move to New Selection Code.
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PREPARE CHECKS

Discrete

Company cec ‘GMIC Consiruction Company Pay Run Group Selection Code | CK
Payment

3 Freeze [ Detsch [ Seach O Workllows v @ ReportOptions v [ Export v § ECMDocumens & User Extensions

Status | Vendor Name Invoice Number | Check# | CheckDate |  Amount Paid Response Error
Vaid A1 Cement nc. R 0000003610 | 17-Jan.2022 220720 [ 226466769

A1 Cementnc. cr3n2 0000003612 | 17-Jan.2022 196903 | 224466762

A1 Cement nc. R 0000003612 | 17-Jan.2022 15085 | 228H4607G2

A1 Cementinc. cR310 20000003612 | 17-Jan-2022 131269 | 2241466762

Grouped Single

A1 CementInc. cR3109 20000003612 | 17-dan-2022 98452 | 224H46G7G2 Payment

A1 Cementnc. cR3108 0000003612 | 17-Jan2022 65634 224H4667G2
A1 Cementnc. cr3107 0000003612 | 17-Jan2022 32818 | 220466762
A1 Cementnc. L
ADOORS | A1 Doors nc. R34 90000003616 | 17-Jan.2022 478125 | 224H46GTHA "
Discrete
AIDOORS | A1 Doors nc. DR313 0000003616 | 17-Jan.2022 430313 | 224H46GTHS Payment
ADOORS | A1 Doors nc. oR312 90000003616 | 17-Jan.2022 382500 | 224H46GTHS
AIDOORS | A1 Doors nc. oR3M 0000003616 | 17-Jan.2022 33688 | 224H4GGTHS
ADOORS | A1 Doors nc. DR310 90000003616 | 17-Jan.2022 26875 | 224H46GTHS

ATDOORS | A1 Doorsnc. DR3109 20000003615 | 17-Jan-2022 239083 | 224H4GTHS

AIDOORS | A1 Doors Inc. DR3107 50000003613 | 17-Jan-2022 143438 224H48GTIT

Close | | Generate RequestFile | | Import Response File | Import Reconciliation File | | Delete Check | | Post Checks | | Move to New Selection Code.





COMDATA – Delete Check Button (21.48799)
The COMDATA pop-up in Prepare Checks screen is added with ‘Delete Check’ button. This button will be enabled only on records where the card token numbers are not populated. Users now can delete the checks that are in a selection code, with some of them already with card token numbers and linked to COMDATA processing. 
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Note: This ‘Delete Check’ button will be disabled for records with Card Token Numbers as they are linked to COMDATA processing already.

EFT Last Check Sequence number (21.47899)
Overview

AP Control file is modified to include ‘EFT Last Check Sequence Number’ input field. 

This field is hidden by default, users must use lite editor to make it visible. 
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Accounts Payable > Setup > Local Tables > Control File – Check tab 

EFT Last Check Sequence Number: Input field showing the last check sequence number for EFT check. The latest EFT check sequence number will be an increment to last check sequence number in AP control file. 

EFT Last Check sequence number is updated as soon as checks are prepared. 

If checks are processed using Pay Run group, system will use the last check sequence number of the paying company. 

Note: Going forward CMiC may have SAME check sequence number across multiple companies. Previously check sequence numbers were unique across all companies and hence the sequence number was used by Non-EFT and EFT checks. With this modification, EFT check numbers will have company specific check sequence number.  If EFT Last check sequence number is 0 or NULL, the next EFT check sequence number will be 1. 

Warning: Users normally should not be updating this field unless otherwise required and be performed by administrators. A role level system privilege to access this field will be provided in the future release, also validations will be added when users update this field.

The field will be automatically updated to current last check sequence number in the system for all the companies with this installation. 

Implementation


Selection Code: E1 

EFT Last Check Sequence Number for CCC company: 843
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Accounts Payable > Setup > Local Tables > Control File – Check tab
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Accounts Payable > Payment > Select Payments
Prepare Checks for E1 selection code 
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 Accounts Payable > Payment > Print Checks – Prepare Checks 
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
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 Accounts Payable > Payment > Print Checks – 2nd Party Checks 
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AP Check Report 
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 Accounts Payable > Payment > Print Checks – Post Check Run 
EFT and NON-EFT Checks 

Selection Code: E2 
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 Accounts Payable > Payment > Select Payments
Prepare Checks 
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 Accounts Payable > Payment > Print Checks – Prepare Checks  
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 Accounts Payable > Payment > Print Checks – 2nd Party Checks 
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 AP Check Report
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
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Un-prepare Checks 

Selection Code: P3 
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 Accounts Payable > Payment > Select Payments
Prepare Checks 
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 Accounts Payable > Payment > Print Checks – Prepare Checks 
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 Accounts Payable > Payment > Print Checks – 2nd Party Checks 
EFT Last Check Sequence is updated to 857
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
Unprepared Checks for selection code P3
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Accounts Payable > Utilities > Unprepare Checks 

EFT Last Check Sequence number is still 857. 
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
Prepare Checks for selection code P3 
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 Accounts Payable > Payment > Print Checks – Prepare Checks 
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 Accounts Payable > Payment > Print Checks – 2nd Party Checks 
EFT Last Check sequence number is control file is updated to 861
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
If Checks are unprepared, unprepared check numbers will be skipped.
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 AP Check Logs
Pay Run Group

Selection code is selected from DHCOM and ZZ company for pay run group 2147899. 
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 Accounts Payable > Payment > Select Payments – Pay Run group 
EFT Last Check Sequence number: 

DHCOM – 843

ZZ – NULL 

In the pay run group, paying company is ZZ. System will use EFT last check sequence number from ZZ company control file. Since, the value is NULL, system will start numbering from 1. 
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
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 Accounts Payable > Setup > Local Tables > Control File – Check tab
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 Accounts Payable > Payment > Print Checks – Prepare Checks  
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 Accounts Payable > Payment > Print Checks – 2nd Party Check
EFT Notification Email - Customization (21.51322)
This enhancement is to pull the EFT notification email content from the TEXT Code Program and allow users to customize their EFT email notification Subject and Body.

Modifications:

1. The Attachment file name has been changed from APEFT to Vendorname.dateofeftfile- Example: BlockIron.20210806 

2. The Email Subject line is being pulled from the Text Code ‘Subject’ in TEXTFM Program

3. The Email Body is being pulled from the Text Code ‘Email Body’ in TEXTFM Program

Following shows the modifications performed:
A new Text Type is added for EFT Notification Email
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Two new Text Codes have been created:

1. Subject 

2. Body

[image: image52.png]TEXT CODE

Selection Criteria

Company | cCC

Q CMiC Construction Company

Bswe Dod 8|0 ®@ A v O

Text Detail

Freeze

Search i Insert % Delete O, Workflows v & ReportOptions v [ Export v @ ECMDocuments v % User Extensions

s [eFT
“Type * Code. ‘Applicant Number Description Edit Description | Print Order
** PLEASE DO NOT REPLY TO THIS EMAIL
EFT BoDY. ** THIS IS AN UNMONITORED MAIL BOX ** it Description,
&0 S APEFT sent on <<DateOnFile>> ] e

TEXT CODE

Edit Description

“* PLEASE DO NOT REPLY TO THIS EVAIL ™
“*THIS IS AN UNMONITORED MAIL BOX ™

“The following funds are in the process of being electronically deposited info your bank account. Electronic funds take 2 business days to process from

the payment date noted.

Financialinsitutions may vary as to when they post slectronic funds, you should verify that funds have been deposited before making a withdraval

Description

Close

|®

|z~




On the Print Checks screen, there is an option to select EFT Email Body. As some of the clients process PY checks from AP, this field ‘EFT Email Body Text Code’ gives an option to choose a different email body.

‘EFT Email Body Text Code’ field gets enabled when ‘EFT/TPPM Distribution’ checkbox is checked.
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Below is an example of the EFT notification email content.
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Privilege to edit Discount amount through Adjust Voucher Status (21.51508)

This enhancement is designed to give User a new privilege to change the discount amount through the Adjust Voucher Status program.

Modifications:

A New privilege ‘APVOUDISC’ has been added. This privilege is required to be able to update the discount amount on Adjust voucher status screen.

Once the privilege has been given to the user, only for the open unpaid invoices (Not Partially/Fully paid) i,e vouchers that do not have any previous paid amount , discount amount field will be enabled in the Adjust voucher status screen.

It is also required that in AP Control File options under Voucher tab, the Invoice Method is set to GROSS method. In case it is set to NET Method, the discount amount field will not be made available for update.

Also, this field will be enabled only for Normal vouchers.

Following shows the modifications performed:
New privilege ‘APVOUDISC’ required to be able to update the discount amount on Adjust voucher status screen.
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Path: System Data < Security < Users < User Maintenance 

AP Control File options under Voucher tab, the Invoice Method should be set to GROSS method.
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Path: AP < Setup < Local Tables < Control File Options

Once the privilege has been given to the user, only for the open unpaid invoices (Not Partially/Fully paid) i,e vouchers that do not have any previous paid amount , discount amount field will be enabled in the Adjust voucher status screen.
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Path: AP < Payment < Adjust Voucher Status

For Partial Paid Vouchers the Discount Amount field will not be enabled with the privilege ‘APVOUDISC’.
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For Deferred Vouchers the discount Amount field will not be enabled even with the privilege ‘APVOUDISC’.

[image: image60.png]ADJUST VOUCHER STATUS

Selection Criteria

*Company CCC Q| [ CMC Constructon Company

Vendor | AfELECT Q| [ A1 Blectric nc.

Job | ) |
Normal Vouchers | Deferred Vouchers
Vews [ fees [ Detach P Seach O Worklows v @ ReportOptions v [L Export v 4 Attachments [5Notes § ECMDocuments v g UserExtensions
PWP | Exceed sgyg | Close | Hold | vengor Vendor Name Job Invoice Code | Invoice Series Code | Invoice Date Due Date DiscountDate | DiscountAmount | VendorAdaress | ch
o ¢ o O | aEEcT A1 Ectic . 2083221 203322.0001-1 suss 22t fo | 2ot G | 222021 fo | 228 oo
o|lole |o O | ateEcT A1 Elctic . 250 250000031 suss 25052020 b | 2406200 6 | 2505220 3 | 000 oo
olec o O | aEEcT A1 Ectic . 250 2sowo0sss | sus w02 o | 022 fo | ssotaz fo | 9 oo
o ¢ |o O | aEEcT A1 Ectic . oz S804 suss oot Gb | osto2rt 6 | 10082021 3 | 000 e
oln o O | aEEcT A1 Ectic . oz an210 oros201 o | 002021 o | ososart fo | S0 oo
0 0 [p alo a O |aeer | | AlEecn PG | oo i | ososzzz fo) |[ososazz (o] ||os0szuzz G| oo al |[on
« ,
Remitance Descrption | )
Status Name | Perm Defer | oraw | | | Compliance | | Joint Payee





When the Invoice Method is set to ‘Net Method’, the Discount field will remain disabled even with the privilege ‘APVOUDISC’.
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'Vendor Name' added to the list of available columns in 'Vendor pick-list' selection criteria. (22.53854)

'Vendor Name' added to the list of available columns in 'Vendor pick-list' selection criteria. (13.81450 was a customization for Pomerleau in V10 Forms, needs to be brought to R12 as well.)

Modifications:

It may be necessary to have vendor pick-list based on the starting alphabet of vendor names to group the vendors for reporting/querying purposes.

The list of columns in the 'selection criteria' popup is modified with the addition of Vendor Name (BPVENDORS)
Modification with an example:
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Record Renumbered Checks as Wasted (21.50780)

This enhancement is to maintain a proper Audit Trail of automatic check numbers generated/consumed by the system when the Checks are Renumbered.
Modifications:
A new flag “Record Renumbering Checks As Wasted” has been added on AP control file under Check tab. By default, this flag will be unchecked.  User will have to check this option manually. 

This flag when checked, records the renumbering checks as Wasted Checks.
Following shows the modifications performed:
New flag “Record Renumbering Checks As Wasted” added on AP control file under Check tab. By default, this flag will be unchecked.  User will have to check this option manually.
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The Last Check Number on the Account 1000.100 is 159.
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Check is prepared for Selection Code: ZM.
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The System picks up Check#160 as expected. Six checks are generated 160,161, 162, 163, 164, 165.
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Checks are Renumbered for Selection Code: ZM.
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Checks got renumbered starting from #166 as expected. 
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Six checks that got renumbered: 160,161, 162, 163, 164, 165 are present in Wasted Checks for Audit Trail purpose.
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New `Include Deposit’ flag in AP Aging Summary Report AP1000S (21.50840)

New `Include Deposit’ flag added in AP Aging Summary Report AP1000S

Modifications:

Include Deposit LOV parameter has been added in the AP Aging Summary Report AP1000S.

Following shows the modifications performed with example:

As shown below a Deposit is created for Vendor: N1Bricks for $500.00.
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Run the ‘AP Aging Summary Report AP1000S’ with the ‘Include Deposit’ as Y.
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As marked below, the Deposit entered for Vendor N1Bricks populates in the ‘AP Aging Summary Report AP1000S’.
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Run the ‘AP Aging Summary Report AP1000S’ with the ‘Include Deposit’ as N.
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As marked below, the Deposit entered for Vendor N1Bricks does NOT populates in the ‘AP Aging Summary Report AP1000S’ as the ‘Include Deposits’ parameter is set ‘N’ this time.
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Nvoicepay rebranding to Corpay(22.53572) 
Overview

Corpay integration with CMiC

Pre-requisites

The following prerequisites are required prior to using Corpay:

 • CMiC Corpay license is required. Please contact a CMiC Account Manager for more information.

 • Corpay account or need to be an existing Corpay user. 

Setup

Set Up EFT File Format
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Account Payable > Setup > Global Tables > EFT Formats

Use the EFT File Format screen to set up the Electronic File Transfer (EFT) format for the banks from which EFT payments will be made.

Client ID and Client Secret information is provided by Corpay and maintained by system administrators. 

Display [Corpay] Button on Prepare Checks Screen using Lite Editor
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Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks – [Corpay] button
The [Corpay] button is located on the Prepare Checks screen in the Accounts Payable module and by default it is hidden. This button is made visible using Lite Editor.
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Displaying [Corpay] button on Prepare Checks screen using Lite Editor

Maintain Vendors

Vendor maintenance must have the highlighted mandatory fields entered. Once all the required fields are entered, user will be able to generate request file. 
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Pgm: BPVENFM – Maintain Vendors; standard Treeview path: Accounts Payable > Setup > Maintain Vendors – Accounting tab

The mandatory fields to be completed in the ‘Accounting’ tab are shown in the screenshot below.

Although banking details are not requested or processed by CORPAY, when the ‘EFT Payments’ radio button is selected on the Select Payments screen, a vendor’s bank account details must also be completed in the Maintain Vendors screen. A valid bank account number can be entered in the Account Number field, or a dummy account number can be entered (e.g., #999999).
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Pgm: APCHQPRE – Prepare Checks; standard Treeview path: Accounts Payable > Check > Print Checks

Preparing Checks for a Selection Code

Step 1: Create Payment Selection Code and Select Payments

Selection Code: CP
Prepare Checks 

Use the Select Payments screen to create a one-time payment selection code. Select the ‘EFT Payments’ radio button and specify any other criteria by which to select invoices associated with the payment selection code. Click the [Add Invoices] button on the Select Payments screen to display the list of matching invoices and select which invoices to associate to the payment selection code. When finished, click on [Save].
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Pgm: PAYSEL – Select Payments; standard Treeview path: Accounts Payable > Payment > Select Payments
Step 2: Generate Corpay Request File

On the Prepare Checks screen, enter/select the company and selection code, and check the ‘Use Voucher Bank Acc’ checkbox. Click on the [Prepare Checks] button
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 Accounts Payable > Checks > Print Checks – Prepare Checks
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 Accounts Payable > Checks > Print Checks – Prepare Checks
The [Prepare Checks] button changes to [Renumber Checks]. A message appears at the top of the screen to indicate the total number of checks prepared and the [Corpay] button is enabled.

Click on the [Corpay] button to launch a pop-up window to initiate the payment/request file generation process.
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 Pop-up launched from [Corpay] button on Prepare Checks screen 

All records must be valid in the Status column for the [Generate Request File] button to be enabled. 

If mandatory fields are not entered properly in the Maintain Vendors screen, as discussed in the previous step, the [Generate Request File] button will not be enabled.

Clicking on [Generate Request File] will launch prepare checks pop-up. Select the file code and EFT format from the LOV. 

File Code: CORPAY
EFT Format: CORPAY
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] button pop-up
[Transfer Payment Info to Corpay] button is enabled once the mandatory fields are populated.

Taskflow process runs upon clicking on [Transfer Payment Info to Corpay] button. 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] button pop-up – Taskflow process
Alert message is displayed with status as ‘DoneParsing’. 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Generate Request File] button pop-up – Alert box
Use [Corpay] button to verify the Corpay status column in prepare checks pop-up. 
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Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button pop-up
Step 3: Approve Corpay Payment batch

Go to AP Gateway to approve the payments.

Click on [View] button to approve the file which is awaiting approval. 
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 AP Gateway - Payments
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 AP Gateway - Payments
Status of the file is ‘Awaiting Approval’ Click on [Approve Batch] button to the approve the whole batch. 

CMiC integration requires BATCH APPROVAL only.

Once the batch is approved, status is changed to Approved. 
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 AP Gateway - Payments
Step 4: Post Checks

Once the payment is approved on AP Gateway, go to AP > Prepare Checks – populate the same selection code as in step 1. Click on [Corpay] button to launch the pop-up. Click on [Generate Request File] to launch Prepare Checks pop-up and click on [Get Corpay Batch Status] button.

Corpay Batch status is updated to ‘ReturnFileReady’, alert message is displayed upon clicking [Get Corpay Batch Status] button.
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] status alert box
[Post Checks] button is enabled when the CORPAY Status column reads ‘ReturnFileReady’ 
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] status alert box
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button pop-up – [Post Checks]

Post Check pop-up will be launched upon clicking [Post Checks] button. Populate the posting date and click on [Post] button. 
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 Post Check pop-up
Report configuration runs and batch is posted successfully. 
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 Post Check pop-up – Report configuration
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 Post Check pop-up
‘Batch Posted successfully’ is displayed in the message box and batch number is auto populated. 

Check Reconciliation and Check Release features

‘Check Reconciliation Date’ field will be enabled when the AP control file flag ‘Automatically Populate Check Reconciliation Date’ is set as Y (checked).  User must enter reconciliation date as required.

‘Check Release Date’ field will be enabled when the AP control file flag ‘Use Check Release Feature’ is set as Y(checked). User must enter release date as required. 

Hold Batch and Cancel Batch 

In AP Gateway payment approval, batch status can be set to ‘Hold Batch’ and ‘Cancel Batch’. Examples of these options are provided below.

Hold Batch Option

Payment Selection Code: CP

Request file is generated and payment info is transferred to Corpay. 
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 Accounts Payable > Checks > Print Checks – Prepare Checks 
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] status alert box
Click on [Hold Batch] button, the payment status is changed to ‘On Hold’ 
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 AP Gateway - Payments
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 AP Gateway - Payments
Click on [Get Corpay Batch Status] button, status returned is ‘DoneParsing’ and the [Post Checks] button is disabled, payment must be approved to post checks. 
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button – [Get CORPAY Batch Status] status alert box
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button
Approve the ‘On Hold’ payment batch. 
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 AP Gateway - Payments
Click on [Get Corpay Batch Status] button, status returned is ‘ReturnFileReady’ and the [Post Checks] button is enabled for posting. 
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 AP Gateway - Payments
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button 
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 Post Check pop-up – Report configuration

Cancel Batch Option

Payment Selection Code: CP

NOTE: Since the Cancel Batch option sets the batch as voided, users must take manual action in the CMIC application and cancel payments as required.
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 Accounts Payable > Checks > Print Checks – Prepare Checks – [Corpay] button
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 AP Gateway – Payments

File status is ‘Voided’ 
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 AP Gateway - Payments
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Click on [Get Corpay Batch Status] button, status returned is ‘ReturnFileReady and the [Post Checks] button is enabled for posting. 

Accounts Receivable

New AR Invoice format-ARINVPRT_UK (21.42827)

New AR Invoice format ARINVPRT_UK.

Modifications: 

Created a new AR Invoice format ARINVPRT_UK.

· New report option will be added to AR Control file Field "Free form invoice Name". 

· ‘Print invoice’ button on Enter invoice screen will be modified to read invoice format report from AR Control file.

· Banking details on the report, AR Cash account on accounting tab on AR control file will be used.

· A User Defined Field is added on the Enter Invoice Screen called "Remarks". This should be printed in a box at the bottom of the Invoice.

The details of how the fields are populated are listed below:

· Company Legal Name: COMP_LEGAL_NAME in DA.COMPANY
· Address format: Street (COMP_ADD1)
Suite (COMP_ADD2)

City (COMP_ADD3), State (the name of the state not the code)( COMP_REGION_NAME)

ZIP (COMP_POSTAL_CODE)

Country (COMP_COUNTRY)

· Vat Reg No: COMP_VAT_REG_NUM in DA.COMPANY

· Invoice details:

Invoice No: INV_NUM in AR#INVOICE

Invoice Date: INV_DATE in AR#INVOICE

Order No: INV_ORD_NUM in DA.INVOICE

Account Ref: Customer code (INV_CUST_CODE in AR#INVOICE)

Quantity: INVD_QTY in DA.INVDETAIL

Description: INVD_TEXT in DA.INVDETAIL

Unit Price: INVD_UNIT_PRICE in DA.INVDETAIL

Net Amt: INVD_AMT in DA.INVDETAIL

VAT %: the percentage on the tax code assigned to that line item

VAT: Tax amount for that line item

Total Net Amount: INV_SALES_AMT in AR#INVOICE

Total tax amount: INV_TAXES in AR#INVOICE

Invoice Total: INV_NET_AMT in AR#INVOICE

· The bank details should be driven from the GL account selected at the customer level for that company. The account name, account number, sort code, IBAN, swift and bank name should all be the ones associated with (Global tables(Banking(Bank account) the GL account for that company.

Account name: BAB_ACC_TITLE in DA.BABANKACCT

Account Number: BAB_ACC_NUMBER in DA.BABANKACCT

Sort Code: BAB_ROUTING_CODE_A in DA.BABANKACCT 

IBAN: BAB_IBAN_NUM in DA.BABANKACCT

Swift: BAB_MICR_CODE in DA.BABANKACCT (Transit field)

· Logo should be populated form the AR control file.
Note: There will not be more than one tax per line.

Setup and printing the AR Invoices:
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AR>Local Tables>Control File Options

Create an AR Invoice and print the invoice. The invoice will need to be launched from the print invoice button in the Enter Invoices program.
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Select All option in Enter Receipt (22.54697)
Overview

Added ‘Select All’ option in Enter Receipt program. 
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Accounts Receivable > Receipt > Enter Receipt – Invoices 
Implementation

Select All checkbox in AR > Receipt > Enter Receipt 
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Selecting all the invoices

[image: image121.png]ENTER RECEIPT

= B B
Enter Receipts Pring it List Post Receipts
[Bank of America (Operating) | (123486789 | (8OA ] ~
Comment | Select All Cenibox ]
Invoice Retated (Recalculate |

Invoice Allocation

|Invoices  GL Distribution  Fin. Charges

vews G [T “ioetsch B Sewen 5 Deiste O Vorklows v & ReportOptions v TR Export v § ECMDocuments v % User Extensions
Company Source Desoription invoice Date | Digceunt | OUStanding | Retsinage | TotalTax Amt | Status | PaymentAmt | DiscountAmt | Allowance Amt | Chrg KON | Remaining Amt
ccc Q||| aroo0001z Q|| | 2808202 | 28082021 7500 | 10000 | ooo)l[o | 7500 | 000 | 000 | 000 000
ccc AR0000001 20520 | 0208201 72000 000 o | o 72000 000 000 000 000
cce ARa00000¢ 0s05201 | 008201 0000 000 0w | o 0000 000 000 000 000
ccc ARa00000z oeaz20t | 0e0z201s 100000 000 o | o 100000 000 000 000 000
cce Ara00000z 202201 | 2102201 1000000 000 0w | o 1000000 000 000 000 000
ccc ARa00000z 1008201 | 10062010 100000 000 o | o 100000 000 000 000 000
cce 180000001 | 48 Draw 1 20201 | We20n | 007000 | 7242000 0w | o 182500 000 000 000 esssssa0
ccc araoooe: | 22 2000201 | 2000201 127500 000 o | o 000 000 000 000 127500
cce 80000002 | 48 Draw 1 2007201 | 2807201 25000 | 120000 0w | o 000 000 000 0w 1000
ccc 1B0000000C | 45 Draw 4 - os20t | ozosz0n | wgmme | ame o | o 000 000 000 o0 |
cce 80000002 | 48 Draw 1 0205201 | 0208201 esom 770 0w | o 000 000 000 000 esom
ccc 180000004 | 45 Draw 1+ Wv20t | wAo20n | 224425 | 240025 o | o 000 000 000 000 | z2uee2s
cce 180000004 | 48 Draw 1 w0201 | 10201 N 0w | o 000 000 000 000 | 1ssas0
ccc 180000004 | 45 Draw 1+ w020t | 10201 r2es02s | 18225 o | o 000 000 000 000 | 12ec02s
cce 180000004 | 48 Draw 1 w0201 | 10201 r2es0zs | 1622 0w | o 000 000 000 000 | 1z2ec02s

000 1500000 000 000 000 s7zsease
< I ———





Update Post Date in AR (21.51353)
Overview

Ability to update batch post date in AR.

Modifications

System privilege PSTCHGAR - Allows the user to change post dates on transactions is added in user maintenance to provide access to this utility. Be default, this privilege is un-checked for the user. 

[image: image122.png]USER MAINTENANCE Taemose | et B[ @ ® A v O

User

 Loginame [DHRUV | - user [HRUV | [ Savetish]

General  Assign Roles | System Privileges | Configuration Privieges  Consolidations Access ~ Company Access ~ Employee Security  Compliance Security

Detach 3 Search  © Workflows v & ReportOptions v [ Export v § ECMDocuments v s User Extensions

J|( JL_J

PoTociR || AR Alows ne userto change post tes anansactions ] o




System Data > Security > User Maintenance > System Privilege 
Change Batch Post Date and Change Batch Post Date Query are the new programs added under the following path in Treeview
Accounts Receivable > Utilities > Change Batch Post Date
Accounts Receivable > Utilities > Change Batch Post Date Query
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Accounts Receivable > Utilities > Change Batch Post Date
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 Accounts Receivable > Utilities > Change Batch Post Date Query
Implementation


PSTCHGAR: Un-checked 

User will not have access to the program
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System Data > Security > User Maintenance > System Privilege 
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Accounts Receivable > Utilities > Change Batch Post Date


Check the flag for the user and user will get access to the utility. 
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System Data > Security > User Maintenance > System Privilege 

Case 1: Updating Batch post date 

1) Invoice Batch 
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Accounts Receivable > Utilities > Change Batch Post Date
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Accounts Receivable > Utilities > Change Batch Post Date
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Accounts Receivable > Utilities > Change Batch Post Date
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2) Updating Memo type batch 
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Accounts Receivable > Utilities > Change Batch Post Date
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 Accounts Receivable > Utilities > Change Batch Post Date
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3) Adjustment Entry batch 
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 Accounts Receivable > Utilities > Change Batch Post Date
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4) Receipt Batch 
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 Accounts Receivable > Utilities > Change Batch Post Date
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 Accounts Receivable > Utilities > Change Batch Post Date
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5) Void Invoice Batch 
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 Accounts Receivable > Utilities > Change Batch Post Date
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6) Void Receipt batch 
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 Accounts Receivable > Utilities > Change Batch Post Date
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Accounts Receivable > Utilities > Change Batch Post Date Query

 
Change Batch Post Date query screen will display all the changed post date log 
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Analytics

BI Catalog – Resource Planning-related Updates Made (21.50685-1,2)

Changes made:
Default Data Source:

- Added new field "Forecast Period Date" to folder "JC Period Balances".

- Added joins:

  "Needs" to "GL Companies"

  "Needs" to "JC Jobs"

- Fixed join between "JC Period Balances" and "JC Job Phases" folders.

Default Dashboards:

· Added new dashboards: Profit Fade and Resource Planning.

· Default Canvas: Added Profit Fade and Resource Gantt cards.

BI Catalog - Updates Made to Most Modules (21.50685-3,4)

Default Dashboard:
· Added new Purchase Order Dashboard
 

Default Data Source changes:
 
Fields modifications:
- folder "GL Companies" - added new fields "Rbq Num" and "Neq Num".

- folder "AP Vendors" - added new field "Payment Purpose Code".

- folder "AP Invoices" - added new fields "Deposit Amt" and "Workflow Status".

- folder "AP Checks" - added new fields "Nvp Pay Batch Id" and "Down Payment Flag".

- folder "AP Voucher Distributions" - added new field "Deposit Amt".

- folder "AP Voucher Payments" - added new field "Rev Code".

- folder "AR Tax Codes" - added new fields "Reverse Chrg Flag", "Authorities Code", "Description", "Eng Translation".

- folder "JC Jobs" - added new fields "Phs Template Code", "Apply Phs Template Flag", "Show Cost Amt Wip Flag".

- folder "JC Transactions" - added new field "Deposit Amt".

- folder "JC Contract Forecast Detail" - added new field "Unposted Pci Spent Amt".

- folder "JCBI Cost Status Query" - folder renamed to "JCBI Cost Status Snapshot".

- folder "SC Subcontract Headers" - added new fields "Deposit Pct", "Deposit Amt", "Deposit Approval Date".

- folder "SC Subcontract SOV Details" - added new fields "Cont Deposit Pct", "Cont Deposit Amt", "Curr Deposit Pct", "Curr Deposit Amt", "Prev Deposit Amt", "Prev Deposit Pct".

- folder "SC Vendors" - added new field "Payment Purpose Code".

- folder "SC Control" - added new field "Deposit Approval Flag".

- folder "SC Voucher Details" - added new fields "Deposit Amt", "Workflow Status".

- folder "CM PCI Detail" - added new field "Markup Flag".

- folder "CM PCI Header" - added new fields "Workflow Status", "Allow Cost Flag".

- folder "CM PCI Detail - Unposted" - added new field "Markup Flag".

- folder "CM PCI Header - Unposted" - added new field "Allow Cost Flag".

- folder "CM Posted PCI Detail" - added new field "Markup Flag".

- folder "CM Posted PCI Header" - added new field "Allow Cost Flag".

- folder "CM Detail Original Budget Posted" - added new field "Markup Flag".

- folder "CM Master Original Budget Posted" - added new field "Allow Cost Flag".

- folder "JB Contract Headers" - added new field "Remit Details".

- folder "JB Risk Management Codes" - added new field "Amt".

- folder "JB Risk Management Rates" - added new field "Amt".

- folder "JBBI Transaction Detail Query" - added new field "Comp Code".

- folder "PO Blanket Purchase Order Headers" - added new fields "Wkfl Status", "Wkfl Signed Date", "Wkfl Routing Comp", "Wkfl Routing Job".

- folder "PRM Transactions" - added new field "Exchg Curr Code".

- folder "PY Employee Master" - deleted fields "Salary Frq" and "Monthly Salary".

- folder "PY Employee Pay History" - added new fields "Exchg Curr Code", "Exchg Rate".

- folder "PY Employee Time Sheets" - added new field "Exchg Curr Code".

- folder "PY Trades Codes" - added new field "Apprentice".

- folder "PY Control File" - added new field "Use Work Comp Curr Flag".

- folder "PM Projects" - added new field "Pre Win Proj Code".

- folder "PM Documents" - added new fields "Sheet Number", "Location Code", "Trade Name".

- folder "PM History" - added new fields "Required Reviewer Flag", "Seq Num".

- folder "PM Journal Headers" - added new field "Wf Approval Status".

- folder "PM Project Partners" - added new fields "Approver Partner Code", "Approver Partner Type", "Approver Cont Code".

- folder "PM Submittals" - added new fields "Curr Review Start Date", "Curr Review End Date", "Curr Review Lead Time", "Review Start Date", "Review End Date", "Review Lead Time".

- folder "DRW Drawings" - added new fields "Location Code", "Sheet Number 1", "Trade Name".

- folder "DRW Annotations" - added new field "Thumbnail Available Flag".

- folder "DRW Documents" - added new fields "Location Code", "Sheet Number", "Trade Name".

- folder "OM Project Table" - added new field "Pre Win Proj Code".

- folder "OMBI Opportunity Query" - added new fields "Job Orig Contract Amt", "Job Contract Amt".

- folder "SP References" - added new fields "Clv Value Code1", "Clv Value Code2", "Clv Value Code3", "Clv Value Code4", "Clv Value Code5", "Clv Value Code6".

- folder "WO Jobs" - added new fields "Phs Template Code", "Apply Phs Template Flag", "Show Cost Amt Wip Flag", "Certrep Email".

- folder "PM Document Types" - added new fields "Sheet Num Title", "Location Code Title", "Trade Name Title", "Sheet Num Active Flag", "Location Active Flag", "Trade Name Active Flag".

- folder "PM Security Roles" - added new field "Internal Only Flag".

- folder "From Project Partner" - added new fields "Approver Partner Code", "Approver Partner Type", "Approver Cont Code".

- folder "To Project Partner" - added new fields "Approver Partner Code", "Approver Partner Type", "Approver Cont Code".

- folder "Responsible Project Partner" - added new fields "Approver Partner Code", "Approver Partner Type", "Approver Cont Code".

 

Added new folders:
- "PYBI Timesheet Query"

- "Py Bi Ca Det"

- "Py Bi Ca Hours"

- "Py Bi Ca Payment"

- "Py Bi Ca Sum"

- "REST API Audit"

- "AR Tax Codes 1"

- "AR Tax Codes 2"

- "AR Tax Codes 3"

 

Added new Joins between folders:
- "JCBI Phase Unit Summary - Earned Value" and "JC Jobs"

- "JC Jobs" and "PO Purchase Order Headers"

- "PO Purchase Order Detail" and "JC Jobs"

- "PO Purchase Order Detail" and "PO Free Form Item Detail"

- "PO Purchase Order Detail" and "IV Item Master"

- "PO Purchase Order Headers" and "PO Purchase Order Batches"

- "PM RFIs" and "Responsible System Contact"

BI Catalog - Updates Made to JC,SD,PM (21.50685-5,6)

New Default Dashboards:

"Expected RFI Dashboard", "Expected Cost Dashboard", "Project and Employee Map"

Default Data Source changes:

Added new folders:
JC Expected Cost 1

JC Expected Cost 2

JC Expected Cost 3

Comparison Project List

Comparison Project List IDs

Comparison Project Details

PM Expected RFI Counts

Deleted folders:
SD System Privileges

PM Programs

PM Project Privileges

Dashboard Builder – Visualization Toolbar Enhancements (21.42008-75,76)
· Visualization toolbar enhancements: 
· Move title text below the toolbar to support longer text 
· Show toolbar controls (Excel export, PDF export, maximize, etc...) on hover 
· Change toolbar colors to grey 
Dashboard Builder – Filters and Substitution Variables (21.42008-82,83)
· Automatically save the selected values of dashboard filters and substitution variables per user.  The persisted values will be used to prepopulate the same dashboard filters and substitution variables when the dashboard is open: 

· Using File -> Open 

· Using a URL obtained from Dashboard -> Get Link... 

· Allow the dashboard filters to load data when autoload data is off (Preferences -> Autoload Data).  This allows the user to select filter values before turning autoload data back on. 

· Add Show Description menu option to allow dashboard builder users to view the folder description specified in Catalog Builder. 
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Dashboard Builder – Selection of Text Color (21.42008-90,91)
Allow Dashboard Builder users to select the text color of a table cell using a format expression. Currently, the feature is not applied to Excel/PDF export yet.

The format expression supports the following operators:
	Comparison Operators
	Description
	Examples

	==
	Equal to
	[Account Type] == “Equity”

	!=
	Not equal to
	[Account Type] != “Equity”

	>
	Greater than
	[Invoice Date] > date(2017,12,17)

	<
	Less than
	[Account Type] < “Equity”

	>=
	Greater than or equal to
	[Invoice Amount] >= 1000 

	<=
	Less than or equal to
	[Invoice Amount] <= 1000


	Logical Operators
	Description
	Examples

	&&
	The double ampersand performs a logical AND operation. It combines two expressions and returns true only if both expressions are true.
	([Account Type] == “Equity”) && ([Invoice Amount] <= 1000)

	||
	The double pipe performs a logical OR operation. It combines two expressions and returns true if one of the expressions is true.


	([Account Type] == “Equity”) || ([Invoice Amount] <= 1000)




The switch function is enhanced (for format expressions only).
The switch function converts an <expression>’s values against a list of values and returns one

of multiple results.

Syntax:

switch(<expression>, <value>, <result>[, <value>, <result>]…[, <else>])

<expression can be a <field reference>, true, false

<value> can be an expression: a field reference, a number, a string, a URL, a date, a function (including another switch function call), combinations of arithmetic/comparision/logical expressions.  

<result> can be a field reference, a number, a string, URL or a date.

<else> can be a field reference, a number, a string, URL or a date.

The data type of the <expression> must be the same as the comparison <value>’s data

type. 

 Examples:

color = switch([Balance Amt], blank(),"#ff0000", 0, "#0000ff", "#00ff00")

color = switch(true, [Account Type] == "Assets", "#00ff00")

color = switch(true, [Account Type] <= "Expense", "#00ff00")

color = switch(true, trim([Account Name]) == "", "#ff0000")

color = switch(true, [Balance Amt] == blank(),"#ff0000", [Balance Amt] > 0, "#00ff00")

color = switch(true, (-15 *([Amount 1]-[Amount 2])/[Amount 3] + 29.76) > 0, "#00ff00", [Amount 4] == blank(), "#ff0000")

color = switch(true, [Account Type] != "Expense","blue",  "#00ff7f", [Balance Amt] >= 50, "#b8860b", "#ed6647")

color = switch(true, ([Balance Amt] >= 0) || ([Account Type] == "Assets") || ([Account Type] == "Revenues"), "#00ff00")

color = switch(true, [Balance Amt] == blank(),"#ff0000", ([Balance Amt] > 0) && ([Account Type] == "Assets"), "#00ff00")

color = switch(true, [Balance Amt] == 0,"#ff0000", ([Balance Amt] + [Credit Amt]) > 0  && ([Account Type] == "Assets"), "green")

color = switch(true, [Balance Amt] < 0,"#ff0000", ([Balance Amt] + switch([Account Type],"Assets", 100, 0)) <= 10000, "#00ff00", "#0000ff")

color = switch(true, [Invoice Date] < date(2017,12,23), "blue", ([Invoice Date] >= date(2017,12,23) ) && ([Invoice Date] <= date(2020,12,27) ), "#ffff00")
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Dashboard Builder – Background Color Selection (21.42008-96,97)
Allow Dashboard Builder users to select the background color of a table cell using a conditional format expression.  The selected color is applied to the Excel/PDF exports.
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Dashboard Builder – Visualization Calculated Field Enhancements (21.42008-111,112)
Below are some Visualization calculated field enhancements (like table conditional formatting): 
· Support comparison expressions and logical expressions switch statements.
· Unlike table conditional formatting: Comparison expressions and logical expressions do not support the STRING data type.
· Support nested function calls.
· Example: 
Rating = switch(true, 
                            'Folder'[Amt] <  10, "A", 
                         ('Folder'[Amt]  +  switch('Folder'[Type],"Assets", 100, 0)) <= 10000, "AA", 
                          "Other")

Dashboard Builder – Bubble Map Visualization (21.42008-118,119)
The Bubble map visualization has been added:
Example:

https://solutionsr12.cmicpaas.com/cmictest/CmicBi/faces/main.jsf?id=kzjxgc61-82403bd363e64f26ad62322e6ed2f6a7
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Dashboard Builder – Table Visual (21.42008-120,121)
Table Visual:

Enables the user to change the final display of numbers without affecting calculations.  Specifically, the following options are supported.

- Change the sign of numbers from positive to negative and from negative to positive (reverse sign).
- Change the sign of negative numbers to positive (absolute value).
- Display negative numbers in brackets.
- All enhancements above are applied to Web, Excel, PDF, Card view and Crosstab view.  They are also applied to pivot items, subtotals and totals. 
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Analytics Enhancement (21.42008-122,125)
Analytics 

Modifications have been made to enable users to assign roles to bucket objects without removing prior assignments.  CMiC also added informative messages to clearly indicate the purpose of the feature.
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Change Management

New year field added to JB Control so that AIA G701 (PMG701) report prints with latest version.

New ‘year’ field added so that latest AIA report version is printed (21.46274)

New year field added to JB Control so that latest version of AIA G701 (PMG701) report prints.
Modifications:
1. New field 'Year' is added on Invoice tab in JB Control.

2. The AIA related fields need to be grouped under 'AIA' section on Invoice tab of JB Control program.

3. Changed the prompt of AIA License Flag from 'AIA G702 and G703 Forms Licensed by Company' to read as 'AIA G701, G702 and G703 Forms Licensed by Company'.

4.  When AIA License Flag is unchecked, the fields AIA License Number, AIA License Expiry Date and Year are cleared and disabled. 

5. ‘Year’ field is validated to be a positive number.

Set up and Printing:

In JB Control, Check the AIA Licence flag 'AIA G701, G702 and G703 Forms Licensed by Company'. Enter the AIA License Number, AIA License Expiry Date and Year of new version of G701 you want to print on the PMG701 report. 
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Print the Owner Change Order document (PMG701) report.
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When the year field is left blank in JB Control, then the document would print 2017 which is the current date of the official AIA G701.
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Print the Owner Change Order document (PMG701) report.

[image: image172.png]AIA' DOCUMENT G701

‘Ghange Order e a
e y— [rs———— owen O
T e o o a
= comcron: 0
T —— arcurecrssmosecrvo: oo 0
Pt oo oo onen O
St vs

I o s s s cre

[ pr—
ot changs by sy stz g O e
oo S e G s
o Conract o ersc by i rdr e e e
o e oS misang T G P

o G o W kB G
et R —

e Crang O s o st o e Convt S Cact T s it
e o s e ety G o D i e e
e e oy b e e v, i e s o G
fricherie ettt

oW e
ey ey Err—

AN Yo St g 1 o . O e . g

TR Caprope o 7 050 001 07y A e A g e





Enhancement Request-For Markups(21.42130)
Overview:
DPR needs the ability for PCI Markup amounts to round to the nearest thousands and hundreds of thousands to cater to South Korea Standards.

Modifications:
The program has been modified so that the ‘Maintain PCI Markup Rules’ screen will now include the following Rounding rule/options while setting up the markup rule
· No Rounding

· Round to Nearest .01

· Round to Nearest 1

· Round to Nearest 10

· Round to Nearest 100

· Round to Nearest 1,000

· Round to Nearest 10,000

· Round to Nearest 100,000

· Round to Nearest 1,000,000

Screenshots:
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Example 1: 
PCI Amount: 3,000,000

Markup Rounding Rule: Round to Nearest 100,000 (hundreds of thousands)

Markup Rule: 8% 

Markup Amount with No Rounding:240,000

Markup Amount with Rounding Applied:200,000 
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Example 2

PCI Amount: 3,000,000

Markup Rounding Rule: Round to Nearest 1,000 (thousands)

Markup Rule: 8.05%

Markup Amount with No Rounding: 241,500

Markup Amount with Rounding Applied: 242,000 
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New Flag ‘Allow Cost’ is added to the PCI header in PCI Entry screen (21.38030)-Beta version released
Overview:
A new flag ‘Allow Cost’ is added to the PCI header in PCI Entry screen. 

Modifications:
The new flag ‘Allow Cost’ is added to header in the general tab on PCI Entry screen. The default value for Allow Cost=Y. This new flag is editable for the unposted and posted PCIs. When unchecked the PCI does not appear for selection in cost transaction screens, MCT, Crew timesheets, Imaging.

Screenshots:
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When Allow cost is checked for a PCI, the PCI is available for selection in the cost transaction entry screen
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When Allow cost flag is not checked for a PCI, the PCI is not available for selection in the cost transaction entry screen
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Note that changes has been made only to ADF and CMIC Field changes are under development.
Employee Self Service

Azure Authentication Enabled for ESS (21.40302 & 21.52029)
Overview

CMiC has added a new checkbox in the Self Service tab of System Options. This box, ‘Azure Authentication enabled for ESS’, should be checked to ensure Azure Authentication is enabled for the Employee Self Service module.
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Prerequisites

1. Check the ‘Access To Self Service’ box for the employee in the Employee Self Service Maintenance screen. This checkbox determines the workflow when an employee is invited to ESS.
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2. Set the employee email address in the Employee Profile.

Modifications

If the ‘Azure Authentication Enabled for ESS’ box is checked, the Employee Self Service Maintenance screen will validate the below information before it allows users to enable ESS registration. 

1. The ESS Maintenance screen will validate if the email address is set up on the Employee Profile.

2. If found, the screen will then search for that email address in the LDAP directory to see if it corresponds to a USERID. 

If multiple USERIDs are found for the same email address the program will display an error message, shown below, prompting the user to clean up their AD account setup. Please note that if emails are set up with multiple USERIDs, then AD may fail. 
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If the email address is not found in the LDAP directory, then an error appears stating that an AD account is not set up for this employee and email address.
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3. The program will then search the portal sec user in CMIC for the same USERID found in the LDAP directory. If the USERID already exists in the portal sec table for another employee, the program will display an error.

If the USERID already exists in the portal sec table without an employee, then the program will sync the employee number in the SYSCONTACT table.

If the information is not found, the program will create a portal sec user and contact for the USERID and sync with the employee number.

4. If all the above conditions are met, the program will then display the USERID on the screen and will allow the user to check the ESS box if all the above conditions are met. The registration email containing the ESS link and USERID is then sent to the employee.
Implementation

This section provides examples of using the new functionality.
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ESS & E Time New Enhancements (21.45876 – Beta Release)
Note: E-time & ESS new enhancements are under development and QA testing. This is a Beta Release.

When creating new employee as a new hire, user now has the option to create a contact code on Employee profile. 

E-time and ESS Changes. 

Create contact code manually by pressing “Create Contact” button in Employee profile under “HCM” Tab:
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When using the E-time registration 

User mapped to employee validation
This means every user must be mapped to the employee. 
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Upon Failure:

User will get the error "User XXXXX is not mapped to any employee. E-Time access cannot be validated" (This only happens when there is a broken link between Contact and employee ID). 

E-time Access validation.

This means very user /Employee must have the E-time Access  enabled under HR>Employee Maintenance.
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Upon Failure 

Employee gets the error “ Employee ‘XXXXX” does not have access to e-time.
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E-Time Registration

Once give the E-time Access employee must go through the E-time registration process to be able to successfully log into E-time. 

Upon Failure 

For any reason employee does not complete the registration process employee will get the error “ Employee XXXX has not completed the E-Time Registration”
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Disabled Access code.
This error only appears when access code is being disabled manually for the personal access code.
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With the new changes now, the system will look in the Access code to check if the employee is linked to the personal access code or to the Group access code. 
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The access code screen only allows creating a Group access code, the user will not be able to create any personal access codes. The personal access codes are for view and allow making limited edits such as.

Maximum Hours

Disabled the Access code flag

Specify Days until the password expires

Change password 

Project manager flag
Group Access Code. 
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No employee number is assigned to the group access code.

No SSO user is assigned to the group access code.

The Group access code has access to the company and pay-runs under the Access code administration screen. 

Pay Runs
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Jobs.
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Accounts.
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Approver.
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Group Access Code Logins.

Employee without E-time Access code. 

When an employee/ user logs into E-time who does not have the Access code, the system will prompt for the access code and password, the user will only be able to use the Group access code to log into the E-timesheet. 
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Employee Login using the Group Access code and Password.
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Employee With E-Time Access Code. 

Switching Between Access Codes. 

Employee / User logins with their Username and password, because their Access code is linked with the SSO system does not ask for the E-time access code and password.

As indicated below we are now showing the access code.

As highlighted below the Username is different from the access code.
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A new icon is introduced to switch the personal access to a grpup asscee code by clicking on the doube arrow keys. 
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As soon this icon is clicked system will ask for the group access code and password and login.
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Same User is now shown logged in as Group Access code.

Switch Back to Personal access code.

User can click on the double arrow to switch back to their personal acc code and system will automatically take user back to their personal access code. 
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E-mail notification-Personal access code:

Setup unapproved Emil address from employee profile- Email in access code screen coming from Employee Profile:
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As soon as you setup approver in access code administration, then Email addres will be populated in access code table mode:
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When Employee submit the timesheet, Email notification will be send out to approver:
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Employee will get notification for unapproved timesheet:

[image: image215.png]Please consider your environmental responsibility before printing this e-mail

From: zohreh.allameh@cmic.ca <zohreh.allameh@cmic.ca>
Sent: January-27-22 11:23 PM

To: Marjan Dehghani <Marian.Dehghani@cmic.ca>
Subject: Time Sheet(s) for Company TRHI2 unapproved.

External Email Proceed with Caution

(TRHI-ACCESS1) code1 Access:
Time Sheet(s) for Company TRHI2 unapproved.
Time Sheets Entered Date: 01/27/2022

Pay Period(s): 52

sincerely,

ZOHREHR12




Equipment Costing 

EC Program/Manual- Sensitive Terminology Replacement (21.47732)
Overview

All References to the Terminology 'Master/Slave' is replaced with 'Primary/Secondary' throughout the software and the Equipment Costing Manual.

Modification

Following screen shows the updated terminology: 

Assemble Equipment Unit: 
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Equipment Costing > Setup > Assemble Equipment Unit 
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Equipment Costing > Setup > Assemble Equipment Unit – Tool tip
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Equipment Costing > Setup > Assemble Equipment Unit – Tool tip
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Equipment Costing > Setup > Assemble Equipment Unit – Tool tip
[image: image220.png]ASSEMBLE EQUIPMENT UNIT

Selection Criteria

Q| | CMiC Test Company

* Company | CCC * As Of Date | 17-Nov-2021 [ |

* Equipment | PRM1

g q Data Filters
Unit Detail
Filter Profile [ Quick v
=3 Free: Plbpon()ﬂims v [ Export v Q ECMDocuments v & User Extensions
Match | All
* Secondary
SEC1 Q| Values
S — | Secondary Unit [ Equals Ml Q) b
.
J

Add Value. Reset Values Reorder Values...

Save Profile Save Profile As... Delete Profile




Equipment Costing > Setup > Assemble Equipment Unit – [Search] 
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Equipment Costing > Setup > Assemble Equipment Unit – [Search]
[image: image222.png]ASSEMBLE EQUIPMENT UNIT Bsae B @ @ @ A | v Q

Equipment SEC1 is already defined as unit for equipment PRM1 on start date 17-NO!

Selection Criteria

* Company | CCC Q. CMIC Test Company * As Of Date | 17-Nov-2021 (Y
* Equipment | ASSET06 Q. ASSET06 View Rates
Unit Detail
Viewv By Freeze Search 4% Insert @ Insert Multiple &= Delete ©, Workflows v & Report Options v [ Export v © ECMDocuments v & User Extensions
* Secondary Uniss. v Name * Start Date. End Date
SEC1 Q) ‘Secondary Equipment 1 [17-Nov-202 TN [Y




Equipment Costing > Setup > Assemble Equipment Unit – Validation 
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Equipment Costing > Setup > Assemble Equipment Unit – Validation
Actual Location Transfer Entry: 
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Equipment Costing > Transaction > Actual Location Transfer > Enter Transfer Transaction – Validation 
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Equipment Costing > Logs > Equipment Units History Log 
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Equipment Primary/Secondary Report
[image: image227.png]C Mz-C CCC - CMiC Test Company Page: 1 of 1
. = Date: Nov 17, 2021
Equipment { Primary/Secondary Report o ST
As of Date: 17:Nov-2021
Equipment Code _ Equipment Name Description Class Start Date End Date HR Charge Rate Total Rate
PR Primary Equipmnet 1 Primary Equipmnet 1 CCC-CLASS $1000 $30.00
sect Secondary Eaupment 1 ‘Secondary Equpment 1 ccccuss TNow202  30Now2021 s1000
secz Secondary Eauiment2 ‘Seconsary Equpment 2 ccccuss Now202  28Now2021 s1000
Primary Unit PRM2 Primary Equipment 2 Primary Equipment 2 CCC-CLASS $1000 $2000
Secondary  sec: ‘Secondary Equipment 3 ‘Secondary Equipment 3 ccccLass 17-Nov-2021 26-Nov-2021 $1000
Unit.
Primary Unit PRM3 Primary Equipment 3 Primary Equipment 3 CCC-CLASS $1000 $1000
Secondary  asseTzet ASSET281 AsseT201 ccecLass 17-Nov-2021 02-Dec-2021 $0.00
Unit.
Total Rate s5000




Equipment Primary/Secondary Report
Purge Non-Chargeable Auto Charge Transactions (21.43479)
Overview

New fields have been introduced in EC control file to purge non-chargeable equipment list. They are hidden by default and user must use lite editor to make them visible. 

Suppress Non-Chargeable records in Review Auto-Charge out program: Flag is un-checked (N) by default. If the flag is checked, Cut-off date field will be enabled. Once checked, user must specify the cut-off date to filter the non-chargeable equipment list in auto-charge out program. 

Cut-off Date: This field is only enabled when ‘Suppress Non-Chargeable records in Review Auto-Charge out program’ flag is checked. 

While processing auto-charge out, non-chargeable equipment whose location transfer date is less than the cut-off date will not be generated and hence not displayed in the non-Chargeable section in Review auto-charge out program. 
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab

Modifications

The following screen i.e EC control file is modified. 

When Suppress Non-Chargeable records in Review Auto-Charge out program flag is checked, cut-off date field is enabled. 

User must specify cut-off date if the field is enabled. [image: image230.png]EQUIPMENT COSTING CONTROL FILE
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab

Implementation

Equipment: SCL55, SCL56 & SCL57. 

Transfer Date to job location 1050. 

SCL55: 1st Nov 2021

SCL56: 1st Nov 2021

SCL57: 1st Dec 2021
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Equipment Costing > Queries > Equipment/Location Query 

EC Control file: Suppress Non-Chargeable records in Review Auto-Charge out program field is not checked. Non-chargeable equipment will not be purged in this case.
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab
Auto-charge out is carried from 1st Nov 2021 to 30th Nov 2021. 
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Equipment Costing > Transactions > Automatic Charge-outs

Auto-charge out is processed successfully, SCL55 and SCL56 equipment has non-chargeable transactions as shown in the screenshot below. 
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Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions 
Case 1: 

Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y) 

Cut-off Date: 31st Oct 2021
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab
Since the equipment transfer date is greater than the cut-off date, non-chargeable equipment list will be shown in auto-charge out review program. 
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Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions 
Case 2:
Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y) 

Cut-off Date: 2nd Nov 2021

The cut-off date is greater than the equipment transfer date, in this is case non-chargeable equipment list will be purged. Since the auto-charge out is processed for SCL55 and SCL56, no transactions will be created in this case. 
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Equipment Costing > Setup > Local Tables > Control File > Charge/Reconciliation tab
SCL55 an SCL56 equipment transactions will not be created.
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Equipment Costing > Transactions > Automatic Charge-outs

Alert message is displayed since no transaction are created in this case of auto-charge out process. 
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Equipment Costing > Transactions > Automatic Charge-outs – Alert message
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Equipment Costing > Transactions > Automatic Charge-outs – Processing Log 
Case 3: 
Suppress Non-Chargeable records in Review Auto-Charge out program: Checked (Y) 

Cut-off Date: 2nd Nov 2021
Equipment used in auto-charge out process: 

SCL55: Transfer Date 1st Nov 2021

SCL56: Transfer Date 1st Nov 2021

SCL57: Transfer Date 1st Dec 2021

Here, SCL57 equipment is non-chargeable but will be processed in the auto-charge out program as its transfer date is greater than the cut-off date.

From Equipment: SCL55

To Equipment: SCL57
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Equipment Costing > Transactions > Automatic Charge-outs

Processing completed successfully and 1 transaction is created. 
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Equipment Costing > Transactions > Automatic Charge-outs

SCL57 equipment is processed for auto-charge out program. SCL55 and SCL56 are non-chargeable equipment, which are purged in the review transaction program as the cut-off date is greater than the equipment transfer date. 
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Equipment Costing > Transactions > Automatic Charge-outs – Review Transactions 

E-Time

Responsible Person Search Filter in Crew Time Approval (21.46333)
Added search filter field for responsible person to E-Time Crew Timesheet approval program. 

Responsible person is assigned to each crew in the Crew Time Mobile App. 

Added a column Responsibility LOV in header filters.  
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E Time Access Code - Email Notification and Setups (21.50017)
Overview

This document provides an overview of how the email address fields are used in the Access Code screen in E-Time.

Access Code
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Access Code Screen in Log View (Table Mode)
[image: image250.png]Available Licenses In Total E-Time

Licenses 999950 Use 40 Licenses 999999
ACCESS CODE DETAIL
Code ZOHREHR12 Type Personal
Employee No TRH-WK-SAL12 $SO User ZOHREHR12

E-Time Roles Disabled [ Project Manager [

Maximum Hours Days Until Password Expires
Use Direct Access Code Emails. Use Employee Profile Emails (Based on Access Code Approver)

Timesheet Approver E-Mai| zohreh1234@gmail com Timesheet/Expense Approver E-Mail
E-Mail For Unapproved Timesheets/Expense zohren allameh@cmic ca Timesheet/Expense Unapprover E-Mail

Expense Approver E-Mail





Access Code Screen in Record View (Form Mode)
The Access Code screen is used for setting up access codes and specifying timesheet/expense approvers and unapprovers for those access codes. 

There are two types of access codes: Personal and Group. The type of access code used in this example is “Personal”.  

For Personal access codes, the password is not used as users will be automatically logged-in based on their SSO user, so users are not able to update or modify the password, the employee number nor the SSO User. For Group access codes, the password and SSO User can be updated if required.
Access Code Detail

The Access Code Detail section of the screen contains two categories for email addresses:

· Use Direct Access Code Emails

· Use Employee Profile Emails
Use Direct Access Code Emails
This section of the screen is used to manually enter email addresses for the user of that access code and for the approver of that access code. We do not recommend to use this option, as this would overwrite the emails used with these “hard-coded” ones instead of using them from the employees themselves based on employee profile.

Timesheet Approver Email

The email address entered here will be the one used for approving the timesheets for this access code. If this field is left blank, the email address used will be the one from the employee profile (specifically the read-only field Timesheet/Expense Approver Email)

Email For Unapproved Timesheets/Expense

The email address entered here will be the one used if a timesheet for this access code is unapproved by the approver. If this field is left blank, the email address used will be the one from the employee profile (specifically the read-only field Timesheet/Expense Unapprover Email)

Expense Approver Email

The email address entered here will be one used for approving the expenses for this access code (based on the access codes security groups). If this field is left blank, the email address used will be the one from the employee profile (specifically the read-only field Timesheet/Expense Approver Email).

Use Employee Profile Emails (Based on Access Code Approver)

When email addresses are not manually entered (hardcoded) in the Use Direct Access Code Emails section of the screen, the email addresses shown in this section will be used. This is the recommended setting.

Timesheet/Expense Approver Email

This email is based on the first approver of the access code, which is set-up in the Approver’s tab of the Access Code Administration screen. For this approver’s access code, the email of the employee linked to it (as personal access code) will be taken. Also, the email to be taken from the employee could be either work email or personal email based on a company control flag.

Timesheet/Expense Unapprover Email

This email is based on the employee that is assigned to this very same access code (as it is a personal access code), Also, the email to be taken from the employee could be either work email or personal email based on a company control flag.
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Access Code Administration Screen
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Company Control Screen

Added Checklist Programs to E – Time (21.51397/HCM-447)
Overview

Checklists provide a way to ask foremen and crew members a series of questions prior to timesheet sign-off. This feature can be used to ensure that proper safety procedures have been followed on the job site.

Adding Checklist Programs to E-Time

Users should add the Check List Maintenance and Crew Check List programs to both the E-Time role and their own personal user role in the Security Roles screen. Examples are shown below.
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After adding these programs they should appear in the E-Time menu, as shown below.
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Creating Checklists

Basic information about setting up checklists can be found at Checklist Maintenance (Beta). The process for creating checklists is much the same for the Field and E-Time applications. However, there are some key features specific to the E-Time version which this article covers below.

Upon creating a new checklist template in E-Time, the below screen appears.

[image: image256.png]* Checklist Name | 0]

* Checklist Code | | "Q-go-ycm|aammdnn5nmnmmchadu v
* Start Date | &) End Date | &
Cmmm‘

B section Title





Category Code

Select from the following options:

Benefit/Deduction Checklist: used for signing off on benefits and deductions.

Crew Checklist: available for any crew member when signing off.

Employee Sign-off Checklist: available for employees when signing off.

Foremen Checklist: available for foremen during the sign-off process.

Fixed Assets

 Added “Include Disposed Off Assets” Checkbox in ‘Asset Query’ Program (22.54640)
New “Include Disposed Off Assets” Checkbox is added in ‘Asset Query’ Program. 

When the Checkbox: “Include Disposed Off Assets” is checked then the Disposed off Assets will get displayed in the Assets Query.

When the Checkbox: “Include Disposed Off Assets” is Unchecked then the Disposed off Assets will NOT get displayed in the Assets Query.

Modification with an example:

Asset: ASSET201 – Not Disposed yet. No Disposal Date.
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In Asset Query when User Unchecks the “Include Disposed Off Assets” Checkbox then Asset201 is displayed.
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Asset: ASSET201 – Asset is Disposed successfully. Disposal Date: 27-05-2022
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In Asset Query when User Checks the “Include Disposed Off Assets” Checkbox then Asset201 is displayed.
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In Asset Query when User Unchecks the “Include Disposed Off Assets” Checkbox then Asset201 is NOT displayed.
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General Ledger

Added Import Button to Maintain Department program (21.48741)
Added Import button to Maintain Departments program

Importing Data:
[Import] button is added to the Maintain departments screen
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Import a few departments
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Data imported successfully
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Updating Inactive Department (22.52670)
Overview
Role level system privilege is added to allow users to update inactive department. 

GLINVADPT: Allow User To View/Update Inactive Department. By default, this is checked for user. 
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Modifications
Case 1: GLINVADPT – Un-checked (N)
[image: image266.png]ER MAINTENANCE Do @0 @ A|Q~

User

 Loginame [DHRUV | - user [HRUV | [ Savetish]

General  Assign Roles | System Privileges | Configuration Privieges  Consolidations Access ~ Company Access ~ Employee Security  Compliance Security

= =

Detach 3 Search  © Workflows v & ReportOptions v [ Export v § ECMDocuments v s User Extensions

# | GLVINADPT JI[ JI[ |

*Code *Name. Select

SomoeT | GL: Alow UserToViewUpaatenacve Departmenis ] o





Validation is raised upon updating an inactive department 
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Case 2: GLINVADPT – Checked (Y) 
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User can update inactive department successfully. 
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Case 3: Adding New Department 

New Department added and deleted successfully 
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Case 4: Deleting department with transactions 
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Case 5: Posting to an inactive department. 
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Update Transaction TAC Values (21.49642)
Overview

Converted Update Transaction Values in GL Utility to R12.

Modifications
‘Update Transaction TAC Values’ program is added in General Ledger utility 

Path: General Ledger > Utilities > Update Transaction TAC Values 
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General Ledger > Utilities > Update Transaction TAC Values
This program allows the entry and/or update of any of the 4 available GL TAC code values if the TAC code has been defined for the Consolidation Chart of the company. The 4 GL TAC columns also have LOV's available.
Company: Select the company code from LOV 

Journal: Select the journal code from LOV 

Further data can be queried using selection criteria fields i.e., Account Pick List, Account, From Post Date, To Post Date, Batch, Department

Exclude Adjustment and Year End Transactions – Check the flag to exclude Adjustment and Year End Transaction from the queried data. By default, this flag is checked. 

After selecting criteria, users must click on [Query Data] button. 

Implementation

Chart Code: CCCHART 

TAC Codes are defined for CCCHART
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TAC values are defined for TAC1 under CCCHART 
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Update Transaction TAC Values 

Populate selection criteria and click on [Query Data] button 
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General Ledger > Utilities > Update Transaction TAC Values

GL TAC Activity Report (GL2500) 
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GL Report – TAC Activity Report (GL2500)
GL TAC Activity Report by TAV Values (GL2501)

[image: image278.png]CCC - CMiC Test Company Page 1 of 1

CMZC TAC ACTIVITY REPORT Loz LB ZnE
Time: 11:20 AMEDT
TAC Code: TAC1 - TAC CODE 1 Year: 2022 Period: 5
Period Actvity Year To Date Actvity

v Debit Cregit Debi Credic

Account: 1000100 Bank of America (Operatng) ‘Deparumen: o Company Level
TAVIMZ TAV1 - REVISION 2 300000 0 300000 000
300000 5% 300000 0%

Account: 5000.100 AP Misc. Expense ‘Deparumen: o Company Level
TAVIM TAV1 - REVISION 1 000 200000 000 200000

0.00 2,000.00 000 2,000.00



GL Report – TAC Activity Report by TAV Values (GL2501)
Update Transaction TAC Values 
Updated TAC values for account 1000.100, 1000.200, and 5000.100. 
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General Ledger > Utilities > Update Transaction TAC Values

Update is validated in GL2500, GL2501 report and Transaction Query screen.

GL TAC Activity report (GL2500) 
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GL Report – TAC Activity Report (GL2500)
GL TAC Activity Report by TAV Values (GL2501)
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GL Report – TAC Activity Report by TAV Values (GL2501)
GL Transaction Query 

[image: image282.png]TRANSACTION QUERY st @@ ® AR~ O

Selection Criteria

* company | ccc Q] [ ctic Test Company. | From Post Date | 31-Hay-2022 |
Journat | G Q| [ Generaloumal | TopostDate | 15un-20226 |
‘Account Pick List | Q| Baten | Q| pepartment | Q| @ Exclude Adjustment And Year End Transactions
Account | al| )
Ledger Detail
Vewv & B search  © Workflows v & ReportOptions v [ Export v ( Attachments [ Notes @ ECMDocuments v % User Extensions
Batch | Company | Department | Account Amount DebitAmount | Credit Amount | cHome | OnGMANG|  Source Code | Source Dese RefCode | RefDescripon | RefDate Post Date TAC Codet TAC Code2 TAC Code3 TAC Code:
s e [T toee| | tomm oo e |1 i i [ | stuay ozt | |[sruay20z2ts | vt e um | ccomw
razs6 | cco o om0z 25000 25000 W a v
s | ccc w© <o00100 ) as000 v | o sty 202ty |[stsy2022t] | v
1azs8 | cco o o100 20000 20000 W a e e o cccnaar
13258 | cec 0 S000.100 200000 200000 | usD | oL S1May20220p | | (3tay-202268 | | Tavin cee uso ceoarT
000 550000 550000
< I — >

AccountName Barkof Anera Opeain) Retorence ]




GL Transaction Query

International Payroll

Transfer of employees between international companies (21.45778)
A new flag is added under system options to allow the transfer of employees from one international company to another in a different country.

Overview

CMiC has added a new flag under the system options screen in the payroll section. The option will determine if the user implemented a CMiC international payroll. The flag can be checked or unchecked. When the flag is checked, the users are allowed to access all employees in profile and history for all companies for all countries without changing “default company” only in international payroll.

Note: Payroll processing changes are not in scope for this modification. The modification only considers Employee profile, Employee History and Employee Import changes. Payroll processing will generate an error against these employees since the tax related tab is not populated. 

Pre-requisites

The flag must be checked under payroll tab in system options for the functionality to be enabled. 
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Modifications

When the flag is checked under system options the employee profile and history screens will hide all tax related information from international payroll screens. The company LOVs is modified to display all companies along with the country code.
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The validation on employee profile and history remains intact and all information are validated based on the company selected such as pay run, pay group or union code. 

The triggers will be created defaulting required values for tax-related fields in profile and history tables. 

Implementation

Employee profile can now be saved with a payroll company that is different than the home company.
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The same changes can be made to employees under employee history for existing or a newly created employee. 
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This change is also applied to import in employee profile. The employee import feature within the ADF screen is modified to ensure that users can import employees without validating tax information. 
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Timesheet can be entered and posted for these employees with the change. 
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New calculation method added for base wage – Dubai Region (21.47918/HCM-421 and HCM-434)
Overview

CMIC has added calculation support for the Dubai region to the International Payroll module. The definition of the base wage in Dubai is a monthly salary which includes monthly allowances. Full wage includes basic salary plus all the employee benefits/allowances. Benefits are calculated as allowances. 

Pre-requisites

The employee package must include the employee monthly salary and the benefit paid to the employee. Therefore, the employee must have both their benefits that are included in the package and those that are not. The non-package allowances are comprised of company contributions and provisions not paid to the employee.

Those benefits can be elected to the employee in the HR module.
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Modifications

The international Employee Profile is modified with a new option to allow users to define salary as monthly for the middle east region to avoid rounding issues. The annual salary is changed to salary frequency. Two options are provided in the frequency field: “Annual” (the default option) and “Monthly”. The Employee Package screen can be viewed from the Employee Profile.
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Benefits that are marked as a “Package” are displayed below. All non-package benefits are displayed in the below section. 
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Implementation

ALEC employees enter timesheets for their time worked. 
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Once payroll is processed, the amount paid to the employee is calculated as: 
The pay amount calculation = Base wage + All allowances (part of the package and non package) = 22,500 (in this case)
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New calculation method added for pro-ration of lump sum benefits – Dubai Region (21.47918/HCM-468)
Overview

CMIC has implemented the functionality of pro-ration for employees hired or terminated mid period. Employees are paid monthly allowances for travel, food, and housing, depending on the camp in which they are housed. These allowances may change mid month if the employee changes jobs/camps or if the employee changes employment situation. 

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

1) Alternate work days must be setup for 7 working days as per Dubai region. 
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2) The master benefit screen has two new checkboxes included in package and pro-rate lump sum benefits

To pro-rate for a lump sum benefit this the pro-rate lump sum benefit box should be checked. 
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Modifications

The benefit master setup screen has a new checkbox for lump-sum burdens to be pro-rated. [image: image301.png]* Job Allocation Based On
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Implementation

An example of an employee terminated mid period and re-hired mid period is shown below.
The following is the employee package with all of the employee’s allowances.
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1) Timesheet was entered for the employee for two months and checks were printed. 
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2) Employee got terminated mid period on the 16 of March,2021.
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3) Timesheet was entered for 16 days of work.
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Printed check for period 3
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4)  Calculations of the pro-rated benefits and BW:

	Period
	3

	Month Days
	31

	Worked Days
	16

	Benefit Changed
	

	Leaves
	0

	FDLA
	600/31 *16 =309.677

	GNLW
	3000/31*16= 1548.3871

	HSLW
	1500/31*16= 774.19

	MDLW
	2000/31*16=1032.25

	SCLW
	1200/31*16=619.35

	TRANS
	1200/31*16=619.35

	BW
	14000/31*16 = 7225.806
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5) The employee got re-hired the 15 of April 2021.
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6) The benefits were re-elected.
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7) Timesheet is entered for the employee for 15 working days starting April 15.
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8) Calculations of the pro-rated benefits and BW:
	Period
	4

	Month Days
	30

	Worked Days
	16

	Benefit Changed
	

	Leaves
	0

	FDLA
	600/30 *16 =320

	GNLW
	3000/30*16= 1600

	HSLW
	1500/30*16= 800

	MDLW
	2000/30*16=1066.66

	SCLW
	1200/30*16=640

	TRANS
	1200/30*16=640

	BW
	14000/30*16 = 7466.66
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New calculation method added for cash and non-cash lump sum benefits – Dubai Region (21.47918/HCM 467 and HCM-468)
Overview

CMIC has implemented a new method to calculate cash and non-cash lump sum benefits. Percentage benefits cannot be pro-rated or part of a package.
Pre-requisites

1) Alternate Workdays should be set to 7 working days as per Dubai region.
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2) Non-cash benefits should not be part of the package or have pro-rate lump sum benefit box is checked. The paid in cash box should be unchecked. 
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Modifications

Include in Package and Pro-rate Lump Sum Benefit boxes are unchecked when the benefit is a percentage. Percentage benefits are paid in cash.
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Implementation

The following is an example using a no-packaged percentage benefit. 

An employee is hired on 10th of January,2021 with a non-packaged percentage benefit. The benefit will not pro-rate as a lump sum benefit. Non-cash benefits pay amounts are part of this example.
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Noncash benefits setup is shown below.
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Percentage cash benefit setup is shown below.
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Base wage pro-rated for 22 days = 12000/31*22 = 8516.12
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Another example with pro-ration of a benefit for an employee hired mid period with a non-cash benefit.

Hired employee 10/Jan/2022 elected a non-cash benefit of CMP1 that is part of the package and with pro-ration box checked.
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After processing payroll to ensure that the benefit pro-rated. The CMP1 benefit was pro-rated for 22 working days starting 10th of Jan until the 31st of Jan. 
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PYC – QC Group Insurance Maintenance (21.49034/18.64007) 
WORK DESCRIPTION:
Ability to change the Employer Contribution based on the Work province of the employee under the QA Group Insurance Maintenance screen. The Company will continue the pay the 70% of the insurance prime in province of Quebec but needs to pay the insurance prime at 100% outside province of Quebec (QC).

PROGRAM MODIFICATIONS:
Province Override Tab:

CMiC has modified the Quebec Insurance Group Maintenance Screen by adding a new tab called the   "Province Override". Province and Employer Contr. Percentage columns will be displayed on the screen. User will be able to enter alternate percentage values for other provinces against the Company and Group Code selected on the main screen. No changes will be done under Group Item/Deduction Codes block.

The existing column "Employer Contr. Percent" on the main screen will be considered as a Quebec Percentage, whereas for the other Provinces user will be able to enter different percentages under this new Override Popup screen. If the Override values are available for the work province of the employee, then system will take that percentage, otherwise system will take percentage from the main screen as per current functionality.

Pre-Requisites

Insurance Benefit Setup – Deduction Codes in CMiC System
The employer contribution of the deductions in the insurance group can be determined with the ability to group a set of related deductions into an insurance group. The user can specify the employer contribution for the group expressed as a percentage, specify the priority order when allocating the employer portion, and specify if each deduction in the group is subject to employer contribution. The amount paid by the employee is not tax deductible, but the amount paid by the employer can be subject to tax.

An Insurance Group can be set up in the Administration -> Deductions -> Quebec Insurance Group screen. The employer maximum contribution is specified as a percentage of the total employee insurance premium. The deductions in the group are assigned a priority to specify the order in which the deductions will be distributed, allocating as much as it can to each until the maximum is reached or there are no more deductions.
Added a new entry of employer contribution percentage override by work province.
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The deductions are set up at the Master, Company and Employee level if necessary. The Employer Contribution flag at the Master Level will indicate if the deduction has an employer contribution or if the deduction is only paid by the employee. 

Deduction HLTH Setup: 
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Deduction DISS Setup:
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In the Tax Elements and Tax Elements by Transaction screens, the user can specify whether the employee deduction is tax deductible or whether employer portion is subject to tax. A deduction code can only have one or the other selected but not both.
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During payroll processing, the maximum for the insurance group is determined by the percentage defined for the group multiplied by the total amount of the employee portion of the deductions.

Test Case Example: ON Province should be calculated at 70%
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The employee total insurance premium amount is $220 (100 + 120) and the maximum employer contribution percentage for the insurance group is 70% for Province of Ontario -ON which is setup under the Province Override Tab. System will calculate the maximum employer contribution amount as 220 X 70% = $154. 

In order of priority, the employer contribution amount is distributed to deduction HLTH (HINT) first at $100 and the employee contribution amount is reduced by $100 which is 0. Then deduction DISS Employer is calculated at $54, and the employee contribution amount ($120) is reduced by $54 which is $66.  Total of above employee and employer deduction premiums are equal to $220 (54 +66 +100).

Test Case Example: QC Province should be calculated at 50%
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The employee total insurance premium amount is $220 (100 + 110+10) and the maximum employer contribution percentage for the insurance group is 50% for QC (setup on the main screen). System will calculate the maximum employer contribution amount as 220 X 50% = $110. In order of priority, the employer contribution amount is distributed to deduction HLTH (HINT) first at $100 and the employee contribution amount is reduced by $100 which is 0. Then deduction DISS is calculated at $10 and the employee contribution amount 120 is reduced by $10 which is $110. 

Total of above employee and employer Deduction premiums are equal to $ 220 (10 + 110 + 100).

Annual Leave Processing - New calculation method added to calculate annual leaves in Dubai region (21.50021/HCM-455)
Overview

CMIC has added a new drop-down column with multiple options on the Hour Type screen to calculate annual leave based on either “Wage”, “Partial package”, or “Full Package”. UAE and its regions have various types of leaves paid for employees. Some of them are regulated by the UAE labour law, such as annual leave. For annual leave, the worker must receive their basic salary in addition to a housing allowance if such an allowance is stipulated in the contract. 

Pre-requisites

1) Alternate Workdays has to be setup to 7 working days as per Dubai region.
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2) Annual leave setup is required.
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3) Setup the Hour Types screen to have annual leaves based on wage, partial package, and full package just like AL1, AL2, and AL3 below.
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Modifications

Employees are entitled to an annual leave of:

2.5 days per month, if they have completed six months of service, but not one year.

30 days, if they have completed one year of service.

The calculation of the duration of annual leave will include official holidays specified by law or by agreement and any other leaves caused by sickness if they fall within the annual leave.

Implementation

Testcase #1: Validate an employee annual leave after 6 months of service and validate annual leave base wage calculation.
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Printed checks for 6 months
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Entered time for period 7 for 15 days of work and 15 days of vacation.
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Validate base wage is calculated as:

	Leave amount paid
	(Monthly wage/days in a month/ hours per day) * leave hour taken
	(14000/31/8)*8 = 451.61
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Testcase # 2:  Validate an employee annual leave after 1 year of work

Processed for 12 months:
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Testcase #3: Validate an employee with full allowance of leave. 
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Checks must be printed for 6 months.
Note: ENTERED 8 HOURS FOR AL2 FOR PERIOD 7.

	Leave amount paid
	(Base with all allowances/days in month/hour per day) * leave hours taken
	(24500/31/8) * 8 = 790.32
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Testcase # 4: Validate an employee with Partial allowance of leave
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Partial package hours entered:
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	Leave amount paid
	(Base with All alowances excluding food/days in month/hour per day) * leave hours taken
	(23900/31/8) * 8 = 770.97
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Testcase # 5: Validate an employee annual leave with full package and partial package using two leave codes
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Full and partial leave hours entered:
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	Leave amount paid (Partial Package)
	(Base with All alowances excluding food/days in month/hour per day) * leave hours taken
	(23900/31/8) * 8 = 770.97

	Leave amount paid (Full Package)
	(Base with all allowances/days in month/hour per day) * leave hours taken
	(24500/31/8) * 8 = 790.32
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Testcase # 6: Validate an employee with benefit increase in the middle of a period (OT and leave)
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OT CALCULATIONS will not consider or include pro-ration.
Medical allowance would calculate as per the increase.
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MDLW: 2000/30*14 + 2500/30 *16 = 2266.66 
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Overtime rate calculation on wages, partial packages, and full packages - Dubai region (21.50023/HCM-424)
Overview

CMIC has implemented a new method to calculate overtime rates based on package. The Hour Types screen has two new columns: “Based on Package” and “Exclusion”. The former is a drop down that shows the three types of packages: wage, partial package (which allows the exclusion of benefits), and full package. 

Pre-requisites

The Alternate Work Days setup required for 7 days a week is shown below. 
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The two new columns added to Hour Types must be added from the lite editor. Setup under hour types is required for overtime. Below is the setup for overtime packages.
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The partial package below excludes food.
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Modifications

When the based-on package is set to “Wage”, the other type of overtime calculation are based on the employee’s basic salary. This type of calculation does not include any allowances in the OT rate calculation. 

When the based-on package is set to “Partial Package”, CMIC payroll allows users to set up OT based on the employee’s gross wages with the ability to include specific allowances. As shown below, the employee continues to receive all allowances except food in the OT rate calculation. 
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When the based-on package is set to “Full Package”, the calculation will include all allowances benefits employees receive in monthly pay marked as package allowance. Any benefit that has the box checked for include in package will be included in the OT rate calculation.

Implementation

1) Below is an example where the hour type is based on “Wage.
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Entered OT hours for a wage package.
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OT calculation for base wage only.

	OT Rate Per Day
	Base wage * Total Months/Total Days
	12000*12/360 = 400

	OT Rate per Hour
	OT rate per day/Work hours per day * OT rate multiplier (1.5 per hour)
	400/8*1.5 = 75

	OT Paid Amount
	OT rate per hour*OT hours worked
	75*10 = 750
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Net pay calculated with all allowances.
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2) An example when hour type is based on “Partial Package” where food allowance has been excluded.
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Entered OT hours for a partial package.
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OT calculation for partial package:

	OT Rate Per Day
	Base wage * Total Months/Total Days
	20,900*12/360 = 696.67

	OT Rate per Hour
	OT rate per day/Work hours per day * OT rate multiplier (1.5 per hour)
	696.67/8*1.5 = 130.625

	OT Paid Amount
	OT rate per hour*OT hours worked
	130.625*10 = 1306.25
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Gross wage calculation:
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Sum of allowances:
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3) An example when hour type is based on “Full Package”.
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Entered OT hours for full package.

[image: image406.png]HEET ENTRY

s Do B @ @ A|D v

PayRun [DBUN Q| |DUBAIMONTHLY
Year 2021
period 1] [owot2021 ® | (31012021
Document | FULL PACK Q
NH Total 248 O Total o/ DoTTotal o Other Total i
Currency | USD Total Hours 258
FULL PACKAGE
Timesheet Details
Employes | ALCENGI03 || FARID REZA AutoRecal | Create Cost Code cat | "1TO0! O Tota ol o 10 Toia Refresh
mployee hours hours s e Hours
Timesheet Details ~ Employee  Equipment \
viewv B Detach Search 4% nsert @ InsertMuliple 7 Delete  l DupiicateRecord G Workfows BReporlO~|s v M Export v [Dimport ¢ Attachments [ Notes »
Double | por
Seqto ~ Employee Date omal | MATHe | wnpayRate | Oferime OLe | oTeaymae DI | fte  pTPayRae| NN Twe | LS | payae | Expense OSSN quanity
Hours e
162100 ALC-ENG103 010112021 iy & ORE 71.4280 o o 75.0000 o | por 100.0000 10 HEL  oT 1343700 v ~
162112 ALGENG103 020012021 s aRE 71.4280 o o 75.0000 o por 100.0000 0 oTHI 50.0000 v
182118 ALCENG103 030112021 i & ORE 71.4280 o o 75.0000 o | por 100.0000 0 otH 500000 v
162118 ALGENG103 04012021 s aRE 71.4280 o o 75.0000 o por 100.0000 [ oTHI 50.0000 v
162121 ALC-ENG103 0si0112021 iy & ORE 71.4280 o o 75.0000 o | por 100.0000 0 otH 500000 v
162124 ALC-ENG103 061012021 s aRE 71.4280 o o 75.0000 o por 100.0000 [ oTHI 50.0000 v
162127 ALC-ENG103 070112021 iy & ORE 71.4280 o o 75.0000 o | por 100.0000 0 otH 500000 v





OT calculations for full package.

	OT Rate Per Day
	Base wage * Total Months/Total Days
	21,500*12/360 = 716.67

	OT Rate per Hour
	OT rate per day/Work hours per day * OT rate multiplier (1.5 per hour)
	716.67/8*1.5 = 134.38

	OT Paid Amount
	OT rate per hour*OT hours worked
	134.38*10 = 1343.75
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Gross wage calculation.
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4) An example of two overtime packages (Full and partial package OT hours).
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OT partial calculations:

	OT Rate Per Day
	Base wage * Total Months/Total Days
	20,900*12/360 = 696.67

	OT Rate per Hour
	OT rate per day/Work hours per day * OT rate multiplier (1.5 per hour)
	696.67/8*1.5 = 130.625

	OT Paid Amount
	OT rate per hour*OT hours worked
	130.625*10 = 1306.25


OT full package calculations:

	OT Rate Per Day
	Base wage * Total Months/Total Days
	21,500*12/360 = 716.67

	OT Rate per Hour
	OT rate per day/Work hours per day * OT rate multiplier (1.5 per hour)
	716.67/8*1.5 = 134.38

	OT Paid Amount
	OT rate per hour*OT hours worked
	134.38*10 = 1343.75
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Company Loans and Advances – Added new pro-rate flag (21.50025/HCM-560)
Overview

CMIC has implemented a new flag to pro-rate loans and advances for Dubai region. Loans and advances will now pro-rate based on the number of days the employee started working or got terminated. This functionality is like the pro-ration of lump sum benefit amount.

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

1) Alternate work days under company is required to be set to 7 working days as per Dubai region working days.
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2) The pro-rate loan amount flag needs to be added from the lite editor:
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Modifications

The loan processing is modified to pro-rate the loan principal or interest amount based on employee workdays. 

Company loan and advances screen has a new flag of “Pro-rate loan amount” added. 
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Implementation

An example of an employee hired mid period with a loan that has its pro-ration loan amount flag checked.

1) Employee hired mid period 16 of January 2021. 
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Employee package screen:
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2) Assign the loan to the employee under employee loan and advances screen:
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3) Enter timesheet for the employee for 16 days of work:
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4) Mid year pay history would show the amount calculated after payroll processing:
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5) Calculations for LP and LI pro-rated for 16 days of work:

LP = 1666.67/31 * 16 = 860.22

LI = 18.33/31 * 16 = 9.46

6) LP and LI will show in full amounts for the next periods of work:
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7) Employee gets terminated in the middle of Nov. 20 th the processing will remain to deduct the default principal amount from the employee loan payment. 

Note: There will be no pro-ration or remaining loan adjustment. 

Note: The employee was hired in the middle of the month of Jan.

In the above scenario, payroll will deduct 860.22 in period 1 and 1,666.67 between 2 and 12.
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Printed checks up to period 12

2,473.08 is the remaining amount after period 12 this amount requires an adjustment
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Period 11 and 12 paid the loan with no pro-ration in full amount.
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Addition of new employee package screen to employee profile as a tree view program for companies in the UAE (21.50722/HCM-466, 467)
Overview

The Employee Profile has a new [Employee Package] button to display package information. This button will display a screen with the employee total base wage and both package and non-package allowances. The amount will be displayed based on the employee pay run frequency. The screen displays all active benefits without an end date.

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

1) The employee package screen in Employee Profile and salary frequency must be added from the lite editor as shown below:

Note: All employees in ALEC are salaried employees with a monthly salary frequency. When a monthly frequency is selected you can add a monthly salary in the rates/salary tab of the Employee Profile. 

[image: image425.png]EMPL(

YEE PROFILE

4 Employee Detail

AYAY

Search 4= Insert £ Delete 4 Previous = Next  ©p Workflows v & ReportOptions v I3 Import & ECM Documents v
[+ Employee #] 4 7 copyEmpioyee & Notes &
Personal = Company Rates/Salary Address HRInfo HCM  Exclude Other Hours  Security  Project History — Work Category
s
7 z
7 7
7 7
Hourly v 7 FulTime N
| —c L L v
Woring N Non-Exemt N4

Allow Accrued Leave 4

) unionized z

| Eigible for Renire 14
% ’
7 s
[ T 7
al 2
o 7 s
o 7 o 7
o 7 o 7
o 7 o 7 3
Y 7 7z

[ 17 [license|cerificate |

_
N

Table Mode

% User Extensions

User Defined Fields.

Upload Photo | | Remove Photo |¢

Create HCM Contact to upload photo?

e Dot @@ @ A





[image: image426.png]EMPLOYEE PROFILE

¥ Lite Editor

TableMode | [ save [P Ext [H

Fields

ad Photo ¢ | Remove Photo [

Fate HCM Contact to upload photo?”

. Remove Program Customizations Editing Level: USER HADR12
4 Employee Detail -
Search 4% nsert i Delete 4w Previous [ €lds  Tabs  TableMode
Block PYEMPLOYEETABLE Field FLAType Advanced
[ Employee #] 7 Empig|
Table Name Column Name Field Widget
Personal | Company Rates/Salary  Addres| | PYAEMPLOYEE PROFILE DropDownList
Row Prompt | FLSAType
Column Titie
|
Tniial Widdle Narme
 —— Visible 1
*SSHI SN
—_— Disabled ecthe FLSA Type (
Hourly
— | width [ 20
| —c L L
e S| .
Display Order | 1120
* Work Stafus | Working
Allow Accrued Leave Single Row
| E— ][ New Row
@ Eiigible for Rehire
ql/| Tab Name | Personal
Union Membership Date oSty Custom
[ i Position Feld
Position Description
e AT % Remove Field Customizations | Add Field
e ° |
e
__° |
Terminafion Date o - .
_— —_— P
Re.Hire Date [ 4 ‘Adjusied Service Date [ 4 o||Z
= e | L e L9
Date Deceased [ 4 * Primary Employee 7

e

— T e

_
N





[image: image427.png]Search and Select: Hidden Field x

4 Search Advanced
Match @ Al O Any

Display Order

Hidden Field

Search | Reset

Hidden Field Display Order

EmpPackageBin

Salary Fra





[image: image428.png]¥ Lite Editor

Remove Program Customizations

Fields = Tabs  Table Mode
Block PYEMPLOYEETABLE

Table Name
PY#ENPLOYEE_PROFILE

Row Prompt | FLSA Type
Colum Title
Visible
Disabled
width [ 20
Display Order | 1120
Single Row [

New Row [

Tab Name | Personal
POSION () pfter O Before
Position Feld

Field FLSAType

Column Name
ENP_FLSA_TYPE

Free-Form Row

Link with Previous Field
Column Span
Tooltip

Default Value

Required

Rows Per Table-
Default

custom

ing Level: USER HADR12

Advanced
Field Widget
DropDownList

o

o

1
Selectthe FLSAType (

N

Remove Field Customizations | | Add Field | Undo || Save





[image: image429.png]able Mode.

EMPLOYEE PROFILE sve [BEit 3 ‘ ® ® A ‘ o~

4 Employee Detail

Search % insert i Delefe 4 Previous  Next O Workfows v & ReportOptions v 3 Import : ECMDocuments v 5% User Extensions.
* Employee # | ALCTESTO1 Employee Full Name | TESTOTALC Copy Employee | Notes
Personal | Company RatesiSalary Address HRInfo HCM  Exclude OtherHours  Secury  Project History  Work Category  User Defined Fields
Prefix 2
* LastName | TESTO1 * FirstName [ALC
Iniial/ Middle Name Suffix
« st sin | 378393876 Aias
“Type | Salaried * Full/Part | Full-Time v
* Status A Acve
* Work Status | Working v *FLSAType | Non-Exempt || salary Frequency | Monthly
Allow Accrued Leave Employee Package Upload Photo | [Remove Photo
Oz Create HCM Contact to upload photo
Elgible for Rehire
Union Q
Union Membership Date Union Member o,
Position Description Q
< DateofBirth (0101180 B Place of Birth
« i Date | 01012021 Seniorty Date % Work Daysivear
Tormination Date % Next Review Date % e
Re.tire Date % Adiusted Service Date % Servicenvears o
Date Deceased % « Primary Employes | ALC-TESTO1
License | Certfcate
ole/faces/console.jspx# Skills




[image: image430.png]ave [ Exit g}‘@@ﬁ\‘rzv

EMPLOYEE PROFILE

4 Employee Detail

Search 4% Insert T Delete 4 Previous = Next O Worklows v & ReportOptions v [ Import . ECMDocuments v g% User Extensions

* Employee # | ALC-TESTO1 Employee Full Name | TESTO1 ALC Copy Employee | Notes.

Personal  Company | Rates/Salary = Address HRInfo HCM  Exclude Other Hours ~ Security  ProjectHistory ~ Work Category ~ User Defined Fields

* Monthly Salary 15,000.00
* Hourly Rate | | * Charge Out Rate * Billing Rate: GC Charge Rate GC Billing Rate
* NWHR Rate | QREG Q| 0ATRegularRate
*OTRate | OVT Q| | overtime
*DOT Rate | DOT Q| | Doudle Overtime
* OTHRate | OTHR Q. other
* Preferred Pay Rate | Job v * Preferred Charge Out Rate | Job v
* Preferred Bill Rate | Job * Preferred Method for Direct Deposit Stubs | Mail v Entered Overtime
Direct Deposit Email Minimum Hour Code Q Entered Double Overtime
Company | ALEC Q| | ALEC UAE Company
Job Q
Cost Code Q
Category Q
Equipment Q
Cost Code Q
Category Q
Tran Code. Q

Override Burden Job Allocation





2) The standalone employee package program can be added from the treeview builder as shown below.
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3) Benefits are elected for each employee from HR> benefit administration> benefit/deduction administration> election by employee program, as shown below. 
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Modifications

The Hour Types screen (under Setup> company) can now be based on types of packages.

The Based-on Package and Exclusion columns can be added from the lite editor as shown below.
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Two new checkboxes have been added to the Benefit Master screen:

1- Include in package – When this box is checked the benefit will be part of the package calculation.

2- Pro-rate Lump Sum Benefit – When this box is checked the benefit calculations will pro-rate based on the start date of the employee. 

These checkboxes can be enabled through the lite editor as shown below.
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The Employee History program also has the employee package and salary frequency, just like the Employee Profile. These fields can be added from the lite editor as shown below.
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Implementation

The following example shows an employee with elected benefits from HR. This is the standalone program showing benefits that are included as part of the package and benefits that are not part of the package. 
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The same can be viewed from the Employee Profile. 
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New Employee Leave Encashment utility to “cash” the leave amount (21.51518/HCM-472)
Overview

CMIC developed a new utility that can be run prior to payroll processing for the period to determine how many employees’ yearly leave cycles have been completed and how much leave encashment the employee is due. The utility checks if the employee anniversary date falls in the period entered on the header and only displays the balances of those employees in the detail section. 

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

4) Alternate workdays should be set to 7 working days as per Dubai region.
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5) The employee must have worked for a year. If they did not use their leaves then the new utility will pay the employee, the leave days in cash.

Modifications


The new utility will allow users to select all employees who have a remaining balance.


The user will select all employees who have been selected to encash the leave amount.

Once employees have been selected, the [Submit] button will insert the data into the adjustment table. The popup will be displayed for all users allowed to choose the pay year and period for leave processing. The popup will default the current open period for the company and pay run from the header. The utility will insert the data into the payroll adjustment table with the leave encashment box checked.
The data can be reviewed by the user and adjusted if needed once verified in the Adjustment screen.
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Implementation

An example of employee encashment is given below for when an employee doesn’t use all of their yearly vacation days.

Checks are printed for 12 months.
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Employee leave encashment program and check the box (include flag) for the employee:
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Select the period where this employee was last paid and click on [Accept/Process].
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The employee encashment information will be transferred to the Adjustment screen where it can be reviewed.
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Unpaid Leave Calculation - New setup screen created for the existing Work Status field in the Employee Profile screen (22.52534/HCM-471)
Overview

CMIC has created a new setup screen for the existing Work Status field in the Employee Profile screen. When an employee is on unpaid leave, they receive no paid wages or allowances. The new setup screen will allow users to put an employee on permanent unpaid leave for a longer period instead of entering unpaid leave timesheets. The employee can be active but on an unpaid leave for as long as required.

Note: This functionality is available for US Payroll and International Payroll.

Pre-requisites

Before changing the work status for the employee, create a new “Inactive” work status. 


The “N” code has the ‘Active Status’ box unchecked.


The “W” code cannot be changed as it is system defined.
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Modifications

The work status code can be up to 4-characters.

These codes can be used in employee profile. 

The processing has been modified to look up the new “Active” status from the setup table for work status. If the work status has an unchecked status flag, then it will not be included for processing.

Note: Timesheet entry will be modified in the next patches to warn users if the employee work status is inactive.
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Implementation
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Above is an example of an employee with an inactive work status.

Below shows that the Employee History work status is in sync with the Employee Profile.
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Shown above is an entered timesheet for the month for the inactive employee and processed payroll.

Note: A warning on timesheet will be added in the next patch
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Payroll Process completed successfully.





An amount of 0 pay is shown below as the employee is inactive for the period. The employee will receive 0 funds.
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US payroll includes the same modification.

Testcase #1: Employee with an inactive status.
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Payroll Process completed successfully.
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The inactive employee has benefits which do not show on mid year pay history even though the exclude without wages box is not checked.
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The employee is processed without a timesheet.
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Nothing is being processed as the employee is inactive for the period.
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Testcase # 2: Employee with an active work status.
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Payroll process will process this status as the employee is active.
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Leave Accruals - Job Allocation checkbox added to the Master Leave Setup (22.52955/HCM-472)
Overview

Some leaves are accrued in a certain region and must be charged to the job. The leave accrual must also accrue based on worked hours in a period for salaried employees. The worked hours are paid wage hours and not the timesheets hours. To enable this, CMIC has added a new Job Allocation checkbox on the Master Leave Setup.
Note: This functionality is available for US Payroll and International Payroll.
Pre-requisites

3) Alternate Work Days should be set to 7 working days as per Dubai region working days.
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4) Job allocation flag should be added from the lite editor and checked.
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Modifications

The Job Allocation checkbox is only enabled when the accrued box is checked. The payroll processing has been modified to allocate the accrued leave on jobs similar to other burdens. Accrual must be allocated to the job charged on leaves only.

[image: image473.png]Table Mode

s Do B @ @ A|D v

LEAVES MASTER

Leave Details

Search % Insert % Delete 4 Previous = Next  © Worklows v & ReportOptions v @ ECMDocuments v s User Extensions

* Leave Code | JLEV

* Leave Description
* Short Description | JOB LEAVE

* Leave Type | Cash .
Accrued
* Accrued Amount By | Fixed Hours .

Carry Forvard
* Accessible In Employee Self Service | No v
* Leave Calculation Method | Pay Run Year v
0 * Include In PY Forecast Burden Calculation
Included I Year of Service Calculation
* Show Leave On Pay Check And Pay Stub





Implementation
The following are examples of how this functionality is used.
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Employee leave after printing check for period 1
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Employee Leave Details – Accrued Leave on the Job/Cost Code and Category

[image: image485.png]EMPLOYEE LEAVES Bswe 80 @ A~

Leave Detail

Vewv B frecze [ Detach 3 Search O Workflows v & ReportOptions v [ Export v  ECMDocuments v s UserExtensions

Year .| CreditAC Dept DebitAC | Hours | Amount | AmountPaid | Total Earnings Total Hours Job Cost Code Category Work Location

2021 6000.400 | 00 5200.100 181 | 67742 0 14000 240 | aLECOT 01100 1000 DuBAl

2021 6000.400 | 00 5200.100 830 4802t 14000 240 | ALECO2 01-100 2000 DUBA

20 1116667 28,000 480




 
[image: image486.png]EMPLOYEE LEAVES Bswe 80 @ A~

Leave Detail
Vewv & freere i Detach (3 Search  ©, Worklows <+ & ReportOptions v [ Export v : ECMDocuments v s User Extensions

Dept DebitAC | Hours | Amount | AmountPaid | Total Earnings Total Hours Cost Code. Category Work Location Leave Calc. §

00 5200.100 677.42 0 14000 240 | ALE 01100 1000 DuBAl 310112021

00 5200.100 830 4802t 0 14000 240 | ALECO2 01-100 2000 DUBA 310112021

20 116667 0 28,000 480




 [image: image487.png]EMPLOYEE LEAVES
Leave Detail
viewvy EF

Year Credit AIC Dept
6000.400 00

6000400 | 00

Search

Debit AIC

00.100

5200100

©,, Worktiows

Total accrued hours for the 2 jobs worked is 20
hours with a break down for each as per the days
worked against each job in the month.

eportOptions v [ Export v 9 ECM Documents +

14000

14000

28,000

Job

240 | ALECO1

240 | ALECO2

480

% User Extensions
CostCode
ot-100

01-100

Bse 8® ® A2+ Q

Work Location

DUBAl

DUBA




 
ALEC01 Job Accrued based on the Formula as under: Leave Hours Accrued = Working Days * (Yearly Eligible Hours/12 Months) / 31 (days in month of January).

18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 11.61 Hours Accrued

ALEC02 Job Accrued based on the Formula as under:

13 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 8.387 Hours Accrued (rounded to 8.39)

PERIOD 2: 18 DAYS OF ALEC01 JOB AND 10 DAYS OF ALEC02 JOB

ALEC01 = 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 28 days for the month of January = 12.86 Hours Accrued

ALEC02 = 10 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 28 days for the month of January = 7.14 Hours Accrued 
[image: image488.png]Detach 3 Search O Workflows v & ReportOptions v [ Export v  ECMDocuments v % User Extensions

5000.400 5200.100 o774z
5000.400 5200.100 ap02t
5000.400 5200.100 750
5000.400 5200.100 714 | 41667

40 233334





PERIOD 3: 18 DAYS OF ALEC01 JOB AND 13 DAYS OF ALEC02 JOB

ALEC01= 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 11.61 Hours Accrued

ALEC02= 13 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 31 days for the month of January = 8.387 Hours Accrued (rounded to 8.39)
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PERIOD 4: 18 DAYS OF ALEC01 JOB AND 12 DAYS OF ALEC02 JOB

ALEC01= 18 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 30 days for the month of January = 12 Hours Accrued

ALEC02= 12 Working Days * (240 Eligible Hours/12 Months = 20 Hours) / 30 days for the month of January = 8 Hours Accrued (rounded to 8.39)
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Test Case 2 – Timesheet entry with Leave code taken against ‘G’ line in the next period against the accrued job leaves.

Leave – Other hour type JL2 is entered as a ‘G’ Line in timesheet entry screen
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TESTCASE #3: G Lines for JL1 (Partial leave package) and JL3 (Base wage)

JL1 EXCLUDES FOOD:

[image: image500.png]B Freee

Description *Type | Excluded?
FDLA BN
oNLw. BN
TRNS a BN
MDLW BN
BN
cup BN

HsLW BN

Save & Close





[image: image501.png]TIMESHEET ENTRY s Do B @ @ A|D v

Timesheet Details

Employee |ALGENG108 | (ARAZPIROOZ AutoRecai | Create Cost Couecat| "1 oo ooy “"T‘J.Zﬁ o) el Retresn
Timesheet Details Employee  Equipment
Search &= Insert @ InsertMultiple 4= Delete @ DuplicateRecord  ©, Workflows v & ReportOptions v [ Export v I3 Import & Aftachments = Notes »
Seq No * Employee. Date [ug Union Trade shift Comp. Job/Dept/Eqp CostCode/Acc/Compon Cat/Tran TshUserFieldS. User Fie
167503 ALC-ENG108 010612021 | I EnG V|| aec ALECO1 01-100 1000 Al
167595 ALC-ENG108 020612021 G | 9 ENG V|| aEc ALECO1 01-100 1000
167509 ALC-ENG108 0310612021 | I EnG V|| aec ALECO1 01-100 1000
167602 ALC-ENG108 04062021 G | 9 ENG V|| aEc ALECO1 01-100 1000
167605 ALC-ENG108 0510612021 (| J EnG V|| aec ALECO1 01-100 1000
167608 ALC-ENG108 0610612021 G | I ENG V|| aEc ALECO1 01-100 1000
167611 ALCENG108 0710612021 | J EnG V|| aec ALECO1 01-100 1000
167614 ALC-ENG108 0800612021 G | 3 ENG V|| aEc ALECO1 01-100 1000
167617 ALC-ENG108 0910612021 (| J EnG V|| aec ALECO1 01-100 1000
167620 ALC-ENG108 100612021 (| J ENG V|| aEc ALECO1 01-100 1000 o
< >

p




[image: image502.png]TIMESHEET ENTRY we Dot B0 @ A~

Timesheet Details

Employee |ALCENG08 | |ARAZPROOZ AutoRecal | Create CostCode cat | "1119%1 o Tota o “"T‘".m ey Refesh
Timesheet Details ~ Employee  Equipment
View v Search &= Insert @ InsertMultiple 4= Delete @ DuplicateRecord  ©, Workflows v & ReportOptions v [ Export v I3 Import & Aftachments = Notes »
ooute | o
Seqto ~ Employee Date Field Names Normal | NHRate  yy pay Rate | Oyertime | OTRate | o7 pay Rate “gy:; gate  poTPayRate QUL Twe | FE PayRate | Expense SO
167653 ALC-ENG108 21062021 G 8 | ORE 583330 0 o 87,5000 o | oot 16,6660 0 otH 583330 ~
167656 ALC-ENG108 2200612021 (i 8 | ORE 583330 o ot 87,5000 o | oot 16,6660 o oTHI 583330
167650 ALC-ENG108 230612021 (i 8 are 533330 o o 875000 o oot 16,6660 o otHl 533330
167662 ALC-ENG108 2410612021 (i 8 | ORE 583330 o ot 87,5000 o | oot 16,6660 o oTHI 583330
167665 ALC-ENG108 2510612021 (i 8 are 533330 o o 875000 o oot 16,6660 o otHl 533330
167668 ALC-ENG108 2610612021 (i 8 ORE 583330 o ot 87,5000 o oot 16,6660 o oTHI 583330
167671 ALC-ENG108 2710612021 iy 8 are 533330 o o 875000 o oot 16,6660 o otHl 533330
167674 ALC-ENG108 2810612021 (i 8 | ORE 583330 o ot 87,5000 o | oot 16,6660 o oTHI 583330
167677 ALC-ENG108 2010612021 (i o are 533330 o o 875000 o oot 16,6660 otHl 533330
167680 ALC-ENG108 300612021 £ 0 arRe 583330 o o 875000 o ot 116.6650 oTHI 583330 o

.




[image: image503.png]Annual Leave Calculation With Partial Allowence

Total Month 12 Days in Month 30
Total Days 360 Regular Hours 2880
ANNL1 - Based on Wage + General Allowence 1.00 Hours Per Day 8
Payroll
Period 6
ANN1 Base $20,900.00
ANN1 Leave taken in Hours 4.00
Monthly Wage $14,000.00
| Wage Adjusted by Leave $233.33
Leave Amount Paid $348.33
Package Allowences
~ General $6,900.00

General Pro-Rated

Allowence Adjusted by the Leave
Transportation

Allowence Adjusted by the Leave
Food

' Allowence Adjusted by the Leave

.

Selection Crteria

camonny Q s

Poyiun OB Q war 2021 Q pvon Ty
okt ACEG1D Q| (PROGE IE

Deser

Mic-Year Pay History

oo (B (I o

Bsews 5wt @ meninage 5 oee

8 st 0, vt

£

P R T e

F—




[image: image504.png]Annual Leave Calculation for Wage only

Total Month 12 Days Worked 30
Total Days 360 Regular Hours 2880
ANN2 - Based on Wage 100 Hours Per Day 8
Payroll
Period PR 0 veAR
ANN2 Base $14,000.00 SR
ANN2 Leave taken in Hours PN
Compry NEG Q) (MECUEGorwany
ooy OB Qv 2021 Q) paraa a
Monthly Wage $14,000.00

Wage Adjusted by Leave
Leave Amount Paid

Package Allowences

oo | ALCENG10 Q| PIROGE ARAZ
$233.33 (]

$233.33]

Mid-Year Pay History

Company [ALEGURE Company oy | OUBHNONTHLY

General
General Pro-Rated

Non-Package Allowence
Medical

Gross Wage

e B O Sowa e Sown @m0

“Conuny | payhm  tvew | hered | empipelo empruntame.
nee | oom 6| wcews seazpRo0z
nee | oom | o | woowws Jeazprooz

$14,000.00

8 votcae s

«

«

oo siart bt 09082321 (5

e

e

% vontows +

20

P

enaome 30082021

000

a0

& Raponcpons +

1400000

1490000

B boon + @ ccupucumens <

ot

ot

soo0010

s

oven

yr—

owatee  ou

o w0
] w



[image: image505.png]e Dot @@ @ A

Selection Criteria

* Company | ALEC Q| | ALEC UAE Company )
* Employee | ALC-ENG108 Q| [ARaz PIROOZ )
* Year | 2021 Q|
| Refresh |

Leave Setup

Query | Setup
Viewv B Frecze () Detach [B) Search  ©, Workfows v & ReportOptions v [ Export v . ECMDocuments v 4% User Extensions
Cote MoursC.rura| oS HAWSCEWI yousused | Howslost | GG, | CPwd | Acced | Accued | ciguows | Eig.Days | HoursRemain
e 0w | 1200 000 000 000 oo | 70002 0o 200 000 12000
aev | oo | oo | oo | w200 | oo || o | 7owot| | ssaer| | 200 | so00] | toso0
o 000 000 000 000 000 000 21000 000 2400
sion oo oo oo oo oo oo 2000 w00 2000
wa o | 1200 000 000 000 o | amz00 0| 200 00 12000
we o | 100 oo oo oo oo | 700002 o | 200 om0 100

Dese [ 108 LENEALES ) [




[image: image506.png]v B0 © A~

Leave Detail
view v Freeze Search  ©, Workflows v & ReportOptions v [ Export v & ECMDocuments v % User Extensions
Year | Per | CreditAC | Dept DebitAC | Hours | Amount | AmountPaid TotalEamings Total Hours Job Cost Code Category Work Location Trade Type.
2021 1 6000400 | 00 5200100 181 | 674z o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 1 6000400 | 00 5200100 839 | 4802 o 14000 240 | ALECO2 01-100 2000 DuBAl ENG A
2021 2 6000400 | 00 5200100 1288 | 750 o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 2 000400 | 00 5200100 714 | 41667 o 14000 240 | ALECO2 01-100 2000 DuBAl ENG A
2021 3 6000400 | 00 5200100 181 | 674z o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 3 000400 | 00 5200100 839 | 4802 o 14000 240 | ALECO2 01-100 2000 DuBAl ENG A
2021 4 000400 | 00 5200100 2 70 o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 4 000400 | 00 5200100 8 as66i o 14000 240 | ALECO2 01-100 2000 DuBAl ENG A
2021 5 6000300 | 00 6000.400 4 2258 22581 ouBAl EnG u
2021 5 6000400 | 00 5200100 774 | 45160 o 14000 240 ALECO1 01-100 2000 DuBAl ENG A
2021 5 6000400 | 00 5200100 181 | 674z o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 5 6000400 | 00 6000300 0ss | 3783 o 14000 240 DuBAl ENG A
2021 5 6000300 | 00 6000.400 4 233 23333 ouBAl EnG u
2021 6 000300 | 00 6000.400 4| 233 23333 DuBAl ENG u
2021 6 6000400 | 00 5200100 2 70 o 14000 240 ALECO1 01100 1000 ouBAl EnG A
2021 6 6000400 | 00 5200100 667 388 o 14000 240 ALECO1 01-100 2000 DuBAl ENG A
2021 6 6000400 | 00 6000300 133 7178 o 14000 240 ouBAl EnG A
108 630754 69247 196,000 3360
< >



[image: image507.png]EMPLOYEE NAME SOCIAL INSURANCE NUMBER  UNION Trade CONTRACTNO  PERIOD END DATE
ARAZ PIROOZ o0 ENG ALECO1 300612021
TAXABLE EARNINGS AND BENEFITS TAXES & DEDUCTIONS

DESCRIPTION RATE HOURS | AMOUNT| To - DATE|DESCRIPTION AMOUNT|__T0 - DATE [DESCRIPTION AMOUNT| __ T0-DATE
Reauier s CEE o e| 89247 [TOTAL" [oTAL"

Reguier Hours oo |0 000 000

Reguier Hours 5545 |0 00| 200000

Reguier Hours 250 |0 00| 1400000

Reguier Hours 553 |20 ta00000| 2800000

roraL 22 rassaas|  maors

108 Leave e |0 000 2581

108 Leave o 11500 oy

108 Leave sexs |o so00 s

VericLe o oo0| 400000

Fooo o so00|  asmaz

ceneraL o 2e5000( 1750101

ousing o tarso0|  sesost

scrooL o 11s000| 710005

RAnsFORT o 11s000| 710005

TOTAL OTHER EARNINGS" s Tesoso|  d0cezer

Leave Code Frwd] Accrued] Used|  Balance|

/OB LEAVE 0.00] 1200 7200 10800

NNUAL LEAVE 0.00] 1200 000 12000

[ToTAL TAXES & 000 000
DEDUCTIONS
CHECK DATE CHECKNO.
30062021 4

TOTAL EARNINGS 1353334 'NON TAX TOTAL 000 ‘CHECK AMOUNT

TOTAL YEAR TO DATE 83,307.53 CO-PD- BENEFITS 2149000




[image: image508.png]Pay: TWENTY-ONE THOUSAND FOUR HUNDRED NINETY DOLLARS 00/100

T0 PIROOZ, ARAZ

THE
ORDER

DBAI 10022

Employee ID

Date

Check No.

ALC-ENG108

30-JUN-2021

48

***21,490.00





Imaging

Flysheet Builder – more enhancements (21.44996)
Enhancements:
PM Attachment dropdown- Allows user to select if the Flysheet should go into PM Attachment.
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Adding the fields from the Panel to the left side (Flysheet Header) will let user create the header Flysheet and corresponding Document Type. The fields can be added in the first part of the Flysheet. 

Save as Draft- Saves the flysheet and creates a background Document Type- that can be opened within Image Manager.

Note- Fields cannot be added directly to Inactive inputs- They can be dragged from the Inputs in the first section.

Features:

Fields can be modified – adding character length, Field name, Radio button options, Checkbox options, Dropdown lists, etc.

Finalize- Creates a Flysheet Structure successfully as shown in screenshot below.
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Generate PDF screen will allow user to add fields to the PDF so that user can download PDF to the local machine.
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Key Points:

1. Flysheet Builder basically helps to create only the Header Flysheets for any Document Type.
2. When we create a Header Flysheet from Flysheet Builder- we can add Flysheets to that Flysheet from ADF Screen. 
3. Once we create a Flysheet from Flysheet Builder- and if I edit it from ADF program- it can no longer be seen in the LOV within Flysheet Builder.
4. Any fields from panel cannot be moved directly into Inactive Input. First, it can be moved to Inputs and then from there, user can drag and drop to Inactive input (Else error message popup occurs)
5. When you type a flysheet name within Flysheet Builder – the background processor creates a same name – Document Type- which can later be edited from ADF screen. Only fields cannot be edited- If you do- you won’t be able to see it in the LOV again.
6. Character length, Mandatory/non-Mandatory fields can be adjusted from the Flysheet Builder. 
Document Types – Added Show in Tree-view flag (22.54645)
Added new flag “Show in Tree-view” in Document types screen. 

Only the document types for which the flag “Show in Tree-view” is checked will be visible in Image Manager Document types drop-down. 
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Image Manager
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Flysheet Definition – Added new field APRI_TOTAL_PAY_AMT_LESS_HLDBK To RAD_APREGINV_V table (22.53352)
New field APRI_TOTAL_PAY_AMT_LESS_HLDBK is added to RAD_APREGINV_V table.

This field can be added to flysheet from flysheet definition. 
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Changed the name for Image Manager and Image Manager Beta (22.56020)
Image Manager is changed to Image Manger Old.

URL: <server>:<port>/<environment>/ImgMgrOld/imgMgrStart.do

Image Manger Beta is now change to Image Manager (standard).

URL: <server>:<port>/<environment>/ImgMgr/imgMgrStart.do

Flysheet Builder – Added Create New Feature (21.50592)
Added [Create New] button to flysheet builder application. 

User will receive a pop-up “This action will erase your current work, do you want to create a new flysheet?” when [Create New] button is clicked from the existing flysheet page.
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Inventory

Added Import feature to Inventory Locations (21.52227)
Added Import feature in Inventory Location
Modifications:
CMiC has enabled the import for CILOCATION table with the following fields:

· Location Code

· Description

· Type

· Control Location

· Department

· Invoice Series

· Zone Code

Note: The location Type must be W (Warehouse) or B (Bin Location). Control Locations must be imported first in a separate file. The system validates if the Control Location exists before allowing the user to create that record, so the user will need to import all the control locations first, save them, and after that import all the child locations that use those records.

Setup and Import:

[IMPORT] button is added to the toolbar
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Sample Import file:
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Import the file created above:
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Job Billing

Added Remittance details on Owner Bill (21.42020)

Changed Remit on Owner Bill
Modifications:
a. Provided a field (optional) to enter remittance details on the company control in JB.

b. Provided a field (optional) to enter remittance details against the contract.

c. Provided an option on the invoice format to print the remittance details.

If the option on the invoice format is switched on, the system will check to see if there are remittance details against the contract. It will print them. If there are no details against the contract, it will print the one from the company control. 

Printing of remittance details will remove the printing of the address (as it does currently with your custom format).

Setup and Printing the Invoice:

Added a field (optional) to enter remittance details on the company control in JB.
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JB>Local Tables>Control
Added a field (optional) to enter remittance details against the contract.
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JB>Contracts>Enter Contract

Added an option on the invoice format to print the remittance details.
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JB>Local Tables>Invoice Formats

Print the invoice when the contract has remittance details maintained against it. The invoice prints the remittance details maintained at the contract level.
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JB> Billing > Print Invoices

Print the invoice when the contract has no remittance details against it. The invoice prints the remittance details maintained at JB Control level.
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JB> Billing > Print Invoices

Print the invoice when the option on the invoice format is switched off so that it doesn’t print the remittance details.
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JB>Contracts>Enter Contract  
Added new invoice Format option-California Notary (21.46227)

New invoice format option (California Notary)

Modifications:
Added a new invoice format option (California Notary), when checked it will print the California G702 Notary format. The ‘Show California Notary’ flag will be hidden, and user will need to add it using the Lite Editor.

All the standard reports will be modified to print the new notary format.
Setup and Printing:
Check the ‘Show California Notary’ flag.
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JB>Local Tables>Invoice Formats

Print the invoice. The invoices print the California G702 Notary format.
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JB> Billing > Print Invoices
G/C Prepare Billing: Mass Update taking absolute value (21.49233)

CMiC have modified GC prepare Billing to allow the users to mass updating the ‘ret %’ and ‘% completed’ of group 1~5 and bill code tab if there is a negative amount on budget.
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JB Transaction Detail Log: Added “Company” field in search as well as column in the table (21.48508)

Added "company" field in search as well as column in the table.
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Job Costing

Added flag “Show Spent as Actual Cost In WIP” to Job Setup (21.46567)
A new flag is added to Job Setup > Settings tab, called “Show Spent as Actual Cost In WIP”. The flag will only be available when the “Show CPR as Cost Amount” flag at job level is checked.

When “Show Spent as Actual Cost In WIP” is checked, the “Spent” column in the WIP program will show actual cost instead of the CPR Amount.
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Added ‘Notes’ button into the Tool bar for Enter Manual Forecast screen (21.48682)
Modified Enter Manual Forecast program (JCREVCAF) to change the Notes function from button to toolbar. User can add new, delete, edit, and close notes in the Notes popup window. 
Please note, Notes added to one record will be shown for all records with the same Cost Code.
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Contact code made mandatory for saving Key Player in Project Maintenance screen (20.36293)
Modified ADF Project Maintenance screen to require Contact if Partner (Company code) is entered on Key Player tab to be in sync with PMJSP.
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New Report Parameter 'Show Quantity' added for JC Cost Transaction JC2000 report (21.48963)
A new parameter added to the existing JC Cost Transaction Report (JC2000) to show/hide the quantity column in the report.

When Show Quantity is set to ‘Y’ the quantity column will be displayed in the report. While exporting to excel the quantity column will be visible

When Show Quantity is set to ‘N’ the quantity column will not be displayed in the report. While exporting to excel the quantity column will not be visible

Show Quantity set to ‘Y’
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The Quantity column is shown in the Excel
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Show Quantity set to ‘N’
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Enhancement-Locking Cost Codes from Deletion/Deactivation Beta Version (21.42643)
Implementation is in progress and Beta version is available for this patch
Overview:
The enhancement will allow the user to lock cost codes in the template and once the template is assigned to the job, the locked cost codes cannot be deactivated or removed from the job. This enhancement will only be available for R12 Enterprise version. No changes will be made to any reports or non-ADF programs
Modifications:

The modifications are made to the following programs
Job Cost Control File- JCCTRLFM:
The following fields are added to the Job Cost Control File 
1. Lock Cost Codes And Categories In Template Assigned To Job: When this flag is enabled, the Locked column will be visible on the Cost Code Template Maintenance screen.

2. Job Cost Code Template: If a template is defined, then all the new jobs created will have that template defaulted on the job.

3. Automatically Apply Template To Job: If enabled, the flag is automatically enabled on the job.
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System Privilege
New System privilege JCLOCKCC is added. When enabled it will allow users to lock/unlock the Cost Codes from the Cost Code Template screen
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Win Lose Bid (JCBIDPRO)
The column Cost Code Template is added. The template will default from Job Cost Control. Users can change from one template to another. 
If Copy Cost Codes is enabled and a template is defined, then both Bid Job Cost Codes and Template Cost Codes will be assigned to the job.
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Cost Code Template Maintenance (JCPHSFM)
The following modifications are made to the Cost Code Template Maintenance screen
1. A new column ‘Locked’ is added to the Cost Code Template screen. When the locked flag is enabled the template cost codes assigned to a job cannot be removed, and if the template cost codes are in the Master list, then it cannot be removed from the master. This new flag will appear in the screen only when “Lock Cost Codes And Categories In Template Assigned To Job” is enabled in Job Control screen.

Only users or roles that have the privilege JCLOCKCC enabled will be able to lock/ unlock the cost codes.
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 Users or roles without the privilege JCLOCKCC will not be able to lock or unlock the cost codes
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2. When the Cost Code is Locked, then the “Active” flag is disabled
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Cost Codes that are Locked cannot be deleted. But if the user has the privilege JCLOCKCC then cost codes can be unlocked and deleted. Users without the privilege should contact the system administrator.
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3. Similarly, when the Cost Code is Locked then the Active flag for its categories will be disabled and delete button will not be visible
[image: image548.png]COST CODE TEMPLATE MAINTENACE

Category Detail

Vewv B

L1000
L2000

L5000

1

Close

Cat Name

L1000

L2000

L5000

Search

4= Insert

Delete button not visible

& Insert Multiple

Billing Type

Budget Method

Amounts

©, Worktiows v

Labour
Forecast

Bse 8|0 @ A~

Time
Phased

& ReportOptions v [, Export v

Spread Rule Code

Active





Active button is enabled for the categories for which cost codes are not locked and delete button is also available
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Assign Job Cost Codes (JCPRODSU)
The following modifications are made to the Assign Job Cost Codes screen
1. When a template is assigned to the job and if the cost codes from the template are locked, then those cost codes cannot be deleted from the job. Alert message is displayed when a user tries to delete the locked cost codes from the job.
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2. For Cost Codes that are Locked in a Template, the Active flag will be disabled 
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3. When the template is assigned to the job and if the template has cost codes that are locked, then the active flag for the categories of the locked cost codes will be disabled. Delete button will also be not available for those categories
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4. When using Add/Remove Categories button, Categories that are included in a Locked Cost Code will not be allowed to delete and the Selected flag will be disabled
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5. If the Categories are added manually (not available in the template) to a locked cost codes on Assign Cost Code screen, then the Selected flag and delete button will be enabled for those categories
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6. When Lock functionality is enabled, then a different message will appear when using Add/Remove Categories from the Selection Criteria block. Only Categories that are not included in a Locked Cost Code will be removed from the Cost Codes
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Enter Cost Code (JCPHSMST)
1. If the cost codes added in the template are locked then those locked cost codes cannot be deleted from the Master list. If user tries to delete the locked cost codes from the Master list then an alert message will be displayed
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2. For Cost Codes that are Locked in a Template the Active flag will be disabled
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3. If a Cost Code is Locked in a Template, then the delete button will not be visible for the categories that are included in the locked Cost Code and the Active flag will be disabled.
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4. When Lock functionality is enabled then a different message will appear when using Add/Remove Categories from the Selection Criteria block. Only Categories that are not included in a Locked Cost Code will be removed from the Cost Codes
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Enter Budget (JCBUDGET)
Active Category flag will be disabled if the Category is included in a Locked Cost Code
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Revise Budget (JCBUDGUP)
Active Cost Code and Active Category flags will be disabled when the Cost Codes are locked, and the Category is included in a Locked Cost Code
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Payroll US

Annual Accrual Leave Cap (21.40679)
A new field ‘Annual Accrual Leave Cap’ is added to the Company Leave screen for accruing accrued leave in a year. If total accrued leave max at a Leave cap level, then system will stop accruing it within the Leave year. If employee uses the same leave within the leave year, then system will not accrue anymore since it has already reached, the Annual Cap Level.

Note: System will consider employee level first. System will consider Table Base, if Leave has a Table Base and Employee Level is setup as Null. Zero is considered as maximum cap ‘0’.
Annual Accrual Leave Cap on Company Level, with Max Accrual and Annual Cap Limit values. 

No Table Base. No Employee Level setup overrides.

Condition below was to set Eligible Days and Hours higher than the allowed eligible to accrue faster. 

Leave Setup Conditions: Table Base (Null), Employee Level (Null), Company Level Setup with max accrual and annual cap.
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Annual Accrual Leave Cap with a Table Base

Basic Table Setup as Factor with Company Level. The Employee Leave stopped accruing when reached max accrual and Annual Cap. Employee did not accrue hours after the Annual Cap Limit was reached.
Leave Code PLT is setup as Hours. The Table Setup has both Max Accrual value as well as Annual Cap Value. 
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Leave accrued hours correctly as per Table Setup and stopped accruing hours based on the table setup and Annual Cap Limit set on the table base.
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Annual Accrual Leave Cap on Employee Level Setup with Leave Table Base. 

Once employee reaches the table base annual accrual leave cap. Enter and set Annual Accrual Leave Cap on employee leave setup. Leave Accrued Amount by Hours. 

Table base but employee override of the Annual cap leave is reached, and employee uses leave hours.
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Employee leave setup takes precedence over leave table base. 

System stopped accruing leave hours as the employee reached the annual accrual leave cap of 8 hours.

Employee Profile Photo Upload (21.44833)
Overview
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee Profile – Personal tab
CMiC has added a new feature which gives users the option of adding a photo to an Employee Profile. The location of the employee profile photo is in the top-right corner of the Personal tab, as shown in the screenshot above.
Pre-requisite

A pre-requisite to uploading an employee profile photo is that an HCM Contact record must be created if it doesn’t already exist for the employee. If an HCM Contact record doesn’t exist for the employee, the [Upload Photo] button will not be enabled on the Personal tab of the Employee Profile.

A Contact record is created for the employee on the HCM tab of the Employee Profile.
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee Profile – HCM tab
For existing employees, the [Create Contact] button will be enabled on the HCM tab. Click this button to create a Contact record linked to the employee.
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Once a Contact record is successfully created, a confirmation message will be displayed, as shown above. 
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee Profile – HCM tab
After a Contact record is created for the employee, the [Create Contact] button will disappear and the ‘Contact Created’ checkbox will be checked at the bottom of the HCM tab. In addition, the Contact Code and Contact Company fields will be displayed. 

On the Personal tab, the [Upload Photo] button will now be enabled.

Implementation
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee Profile – Personal tab
The [Upload Photo] and [Remove Photo] buttons will be enabled on the Personal tab of the Employee Profile only if the employee has an existing Contact record created, as detailed in the previous Pre-requisites section.
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Pop-up window launched from [Upload Photo] button on Employee Profile

Click the [Upload Photo] button to launch the Attachments pop-up window, where a classic upload screen is used to upload a photo. 
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Pgm: PYEMPLOY – Employee Profile; standard Treeview path: US Payroll > Setup > Employees > Employee Profile – Personal tab
Once the photo is successfully uploaded, it will be displayed on the Employee Profile.
This photo will be synchronized with the ADF User Maintenance screen and ESS Profile Information screen.
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In the ESS Profile Information screen, the same photo will be automatically displayed.

Users can update the photo from the ESS screen when the status is “Pending” or “Rejected”. 
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Pgm: SDUSRMNT – User Maintenance; standard Treeview path: System > Security > Users > User Maintenance - General tab
In the ADF User Maintenance screen, the same photo will be automatically displayed. 

NOTE: In all these screens, only one photo can be uploaded. Uploading more than once will only replace the photo previously uploaded. The photo uploaded in any of these screens will be reflected in all screens, since it is the same employee and only one profile photo is kept for each individual employee in the system.
New York Certified Payroll (21.46636)
Overview

CMiC has developed and added a custom Certified Report called ‘New York Certified Payroll Report’. This report DOES NOT replace the standard CMiC Certified Report.
Pre-requisites

The user should map Transaction codes in the certified Payroll Mapping screen. A new column “Journeyman/Apprentice” has been added to the Trade Code screen. This column is hidden by default so the user should enable it through Lite Editor. In the Certified Report Info tab of the Job Work Location screen, a new field Employer Email field has been added.
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Modifications

The heading of the Certified Payroll will be the same as for the DEP Certified Payroll. 

The header will include the following columns:
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Employer Name is Job Company Name

Employer Address is Job Company Address 

Payroll# is Period Number 

Working Ending date is Period End Date

Name of Prime Contractor is Job Company Name 

Employer Email address - add the email address field on Job Work Location screen
Contract Registration - which has been setup under Job Work Location screen.

Employer Phone# - add a contact number for certified report verification
Agency - add a field and users can add agency information as free form text (no validation) up to 15 characters 

Employer Tax ID - Federal Id Number (FEIN) of the company
Agency Pin - add a field and users can add agency pin information as free form text (no valid ation) up to 15 characters.

Project Name - Job name

Project Address - Job Address 
This report should show the last four digit of the employee’s SIN#  

Mask the social security up to last four- digits.

Column 2 (Exemptions) has been removed from the report

Work Classification should include local number and check box for Journeyman/Apprentice should be the top line and OT should be underneath ST- The local number is the union code and the short description of the union.

Walsh will update all existing trades with the proper value and will continue to update the value when adding new trades in the future.

If the value is not defined as J or A, then default value will be taken as J- Journeyman.

Columns 4, 5, 6 and 7 are correct

Column 4 weekdays are correct on existing federal certified report.

Column 5 total hours are also correct, and no change is required.
Column 6 hourly rate & column 7 gross amount are also correct.
Column 8 will be one column for “Withholding and Deductions”
Remove the separate Columns for Fed, Tax, FICA, Local/State Tax. SDI and Vacation Holiday. They should be aggregated. The amount in this column should be difference between Gross Pay and Net Pay. All the mapping columns will be removed except “Fringe Benefits” and “Others”. These 2 will remain on the report.

Column 9 should be “Net Pay”, remove check NO

The Net Pay remains as is with the same calculation to add all employees gross wage minus deductions.
The final column should be “Hourly Contributions to Benefits Funds” (Total Benefits)

The rest of the columns from the New York Certified report will not be considered in this work order

Parameter screen

 All the options will remain. The “Print Benefit by Trade” checkbox will only work for mapping columns for “others” and “Fringe Benefit”.
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The bottom of report should have the disclaimer and signature lines

NOTES: This enhancement is not to create the same report available on New York DOL website (see report below).
The report is not a replacement for the federal certified report.

This report will be a permanent custom report for Walsh for NY.
Implementation

The report should be added to the menu through Treeview builder. Target name is PY -JSREP- NYC Federal Certified Payroll.
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Oracle Import – Addition of Employee and Customer Number (21.48401)
Overview

A new column has been added to Import Timesheets from Oracle CTL file. This column will allow customer data mapping. Through customer data mapping, system allows mapping external employee numbers, shift code, hour types of codes to CMIC employee numbers, shift codes, hour type codes. These mapping are then used during timesheet import if the import file contains external employee numbers, shift codes, and hour type codes. 

Pre-requisites

1) To use cost code, category mapping by trades feature, a timesheet import template must be created and then assigned to a corresponding job on Job Costing>>Job>>Enter job program under payroll tab as shown below:
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2) To use Customer Data Mapping feature to map external employee numbers, shift codes, hour type codes, a mapping code must be created and then assigned to corresponding job on Job Costing>>Job>>Enter job program under Payroll tab as show below:
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Modifications

A new column was added to the ctl file on import timesheet from oracle. This column “IMP_TSH_CUST_EMP_NO” was added to the end of the ctl file to allow customer data mapping easily. 

Note: If this column is not to be used a comma must be added for the last column to allow a successful import.

Implementation

The following example demonstrates how the system maps customer data when it’s specified in the import file.

Step 1: Create an import template and assign it to a job. As shown below, cost code and category are mapped to a trade class, trade code:
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Step 2: Create a customer data mapping template and assign a customer employee to an employee:[image: image599.png]Seach for programs. H CUSTOMER DATA MAPPING Bsave e & \ @ @ A \ v Q
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Step 3: As shown below, the employee number does not have a value and the trade code is left blank as well.
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Step 4: Import the file: 
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Step 5: As shown below, the timesheet entry is created successfully and employee number was picked up as per the mapping:
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New PY Positive Pay File Format for Citibank (21.49766)
New PY Positive Pay file format for Citibank

Modifications:
CMiC added a new positive pay format for Citibank under Check EFT Register.
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Able to generate format and download it.
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New setup screen created for the existing Work Status field in the Employee Profile screen (22.52534)
Overview

CMIC has created a new setup screen for the existing Work Status field in the Employee Profile screen. When an employee is on unpaid leave, they receive no paid wages or allowances. The new setup screen will allow users to put an employee on permanent unpaid leave for a longer period instead of entering unpaid leave timesheets. The employee can be active but on an unpaid leave for as long as required.

Pre-requisites

Before changing the work status for the employee, create a new “Inactive” work status. 


The “N” code has the ‘Active Status’ box unchecked.


The “W” code cannot be changed as it is system defined.
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Modifications

The work status code can be up to 4-characters.

These codes can be used in employee profile. 

The processing has been modified to look up the new “Active” status from the setup table for work status. If the work status has an unchecked status flag, then it will not be included for processing.

Note: Timesheet entry will be modified in the next patches to warn users if the employee work status is inactive.
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Implementation
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Above is an example of an employee with an inactive work status.

Below shows that the Employee History work status is in sync with the Employee Profile.
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Shown above is an entered timesheet for the month for the inactive employee and processed payroll.

Note: A warning on timesheet will be added in the next patch
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Payroll Process completed successfully.





An amount of 0 pay is shown below as the employee is inactive for the period. The employee will receive 0 funds.
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US payroll includes the same modification.

Testcase #1: Employee with an inactive status.
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Payroll Process completed successfully.
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The inactive employee has benefits which do not show on mid year pay history even though the exclude without wages box is not checked.
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The employee is processed without a timesheet.
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Nothing is being processed as the employee is inactive for the period.
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Testcase # 2: Employee with an active work status.
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Payroll process will process this status as the employee is active.
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Show Reprint ALERT on Pay Stub Printing Screen (22.53072)
Overview
CMiC has added more flexibility to pay stub printing. Now when printing pay stubs using the Payroll Check Printing screen, users have the option to avoid re-printing pay stubs that have already been printed. In addition, this functionality has also been added as an alternate feature to the Pay Stub Printing screen. The alternate feature on the Pay Stub Printing screen is disabled by default and will need to be activated by a programmer (i.e., feature is not enabled/disabled on the Payroll Control screen).
Pre-requisites
To use the re-print alert functionality on the Pay Stub Printing screen, the new alternate feature will need to be enabled: “SHOW REPRINT ALERT ON PAYSTUB PRINTING SCREEN”.

Modifications
Enhancements have been made to the Payroll Check Printing screen (standard Treeview path: US Payroll > Processing > Check Printing) and the Pay Stub Printing screen (standard Treeview path: US Payroll > Processing > Pay Stub Printing). In the Payroll Check Printing screen, when the ‘Print Direct Deposit Stub’ checkbox is checked and the [Print] button is pressed, the Pay Stub Printing screen is launched as a pop-up window. The first time this printing process takes place (i.e., no stubs have been previously printed) for the company, pay run, year, period, pay group, and employee combination entered in the Payroll Check Printing screen, all pay stubs will be printed or emailed.  

If the printing process is repeated a second time and some pay stubs have already been printed for that company criteria, the Payroll Check Printing screen will launch a pop-up Alert message to confirm if the user wants to “Reprint Checks?”. If the [Yes] button is pressed, all pay stubs will be printed or emailed. If the [No] button is pressed, only unprinted stubs will be printed.

NOTE: The Alert message is only triggered on the Payroll Check Printing screen after the print process is repeated a second time. It will not appear again if the process is repeated three or more times.

For MOSS, an alternate feature was added to the stand-alone Pay Stub Printing screen, which is launched from the Treeview. The alternate feature is called: “SHOW REPRINT ALERT ON PAYSTUB PRINTING SCREEN”. When this feature is enabled in the stand-alone Pay Stub Printing screen, the screen will function in the same fashion as the Payroll Check Printing screen, but the Alert message will continue to be triggered if the printing process is repeated when pay stubs have already been printed for specific company criteria.  

Implementation

When the alternate re-print alert feature is enabled in the Pay Stub Printing screen, if no stubs are printed for a company, pay run, year, period, pay group, and employee combination, all the pay stubs will be printed. If unprinted stubs exist for the above combination, a pop-up Alert message will confirm if the user wants to “Reprint Stubs?”. If the [Yes] button is pressed, all pay stubs will be reprinted, and if the [No] button is pressed, only unprinted pay stubs will be printed.
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Pgm: PYSTUB – Pay Stub Printing; standard Treeview path: US Payroll > Processing > Pay Stub Printing
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NOTE: Please note that this feature applies to Standard Stubs, not Customized Stubs.

If a user runs it again from the Payroll Check Printing screen, the Alert message will not be displayed.
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Re-Calculate Salary Charge Rate New Option (22.54668)
Overview

A new option “Employee total cost charge per period by default charge rate {profile}” is added on the payroll control file to re-calculate the salary charge rate. The existing re-calculate salary charge rate works based on an existing calculation and on employee salary paid in the period. The user can now change to the new method which is based on the total cost for the period based on the employee default charge rate setup in employee profile. 

Pre-requisites

5) Select the new option of re-calcuate charge rate based on “Employee total cost charge per period by default charge rate {profile}.
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6) Set salary charge rate calc method, the flags and salary charge rate processing option as per the screenshot below.
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Modifications

A new option of “Employee total cost charge per period by default charge rate {profile}” is added to re-calculate charge rate based on dropdown menu. This will allow user to use the charge out rate set on employee profile.

The processing of the re-calculate charge rate is also modified to consider the new option. Both the below highlighted options use the new base method for calculation. 
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Implementation

The following are examples of how the new functionality can be used:

Example #1: The following is an employee with charge out rate of $40. Worked 50 hours per week. The charge out rate and amount are adjusted as per the new functionality. 
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Formula: ((THP * ECR)/ THW) * THW

Formula: ((Total hours in a weekly period * employee cost (charge) rate)/ Total hours worker)* Total hours worked.

((40*40)/50) * 50 = 1600

Example #2: The same employee with 60 hours of work in a week.
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Formula: ((40*40)/60) * 60 = 1600
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Project Management

Self Service and Subcontractor Prequalification – Enhancements (21.38593)
Enhancements have been made in both Subcontractor and Self Service Prequalification screen. Some items have been added/removed.
Self Service Prequalification enhancements:

Field Security has been added for the “Select All Regions” checkbox in the region section on Page 1. It can be made ‘Hidden’ or ‘Unrestricted’ in the Security > Role Maintenance screen (for the Prequal Self Service program).
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· In ‘Financial Information’ section (page no. 4), changes have been made to default Fiscal Date to Dec 31 vs Jan 31.
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· A new button [Assign Classifiers] has been added to the Prequalifications Control screen next to [Checklist Maintenance] button. This button has been secured by Field Security (Hidden/Unrestricted).
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Clicking on the button displays ‘Assign Classifiers’ pop-up, in which six classifier columns have been added for ‘References’ section on Page 5.

{NOTE: CMiC Classifiers functionality does not support Drop-Down type and it can only be an LOV.}
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· In the Prequalifications Control screen, the ‘Self Service – Other Attachments’ drop-down list has been replaced with a Multiselect LOV pop-up. This pop-up determines which Document Types are available in the Document Type drop-down list in the Attachments section on page 6 of the Prequal form. The LOV has three checkboxes:

1. Include (multiple Records - determines if the associated Document Type will show up in the drop-down list in the Attachments section on page 6 of the Prequal form. When unchecked the Required and Display by Default flags are disabled.)

2. Required (determines if the Document Type is required for form submission. When checked Display by Default checkbox will be automatically checked and disabled.)

3. Display by Default (ensures that a line in the Attachments section is shown by default with this Document Type pre-selected from the drop-down list, however, uploading a document of this type will be optional if the required flag is not checked.)
On clicking the Accept button on the LOV, changes to both Financial Attachments (if any) and Other Attachments will be saved. The selected Document Types will be available in Attachments section on Page 6 as Document Type drop-down list for each attachment.
        [image: image646.png]Contractor Prequalification

4 Applicants
83
Self Service
Contractor Rating Setup
Subcontractor Rating Questionnaire Setu
Prequalfications Control

Workflow Notifi

ation
4 Document Management
Documents
» Document Packages
4 Maintenance
Menu Maintenance
4 Security
User Maintenance
Role Maintenance

User Access

C Approval Status Setup Save || & Checklist Maintenance | (£ @
g~
<b>Please Review your data entered. Ifyou need to make any corections you may go back and do so. Once you are satisfied,
please ciick the 'Submit button at the bottom of this page. <>
Review Self-Service Application
y
Project | Co ZZ Default Project a
Self Service - Financial Attachments  Subcontractor Frequaication v| Oustony @ Required (@) Display by Defautt
Self Service - Other Attachments  Maintain LOV_Q
is ContractiChange Or| (@) Moxzilla Firefox - [=} X lgemem
more defaik
[ERGTCICD OV SnulelBruiectii it © # 25 devévi2.cmicca:8888/cmicdevv12/PmMeetingMinute sss | =
y
ponvscicnegge
-W [<<rrevse | EYRPEEENE Next set>> |
Contract/CO Over Aggregate Project Limit
Document Type Include Required Display by Defautt Z
| Warning Only
Classification Section Required [ Atacnments. o o o
Display Financial Calculations in Self-Service []
Bond Documents.
Enable Financials Required Prompt (]
Self.Service (3) References are required. (] Centcatons o @
Insurance Requirements List are Mandatory
orawngs @ o ]
Altenate Self-Service URL.
Oswa Cans @ 2
Number of Required Attachments 1





NOTE:  For each Document Type (Financial and Other attachments) for which Display by Default flag is checked, one row will be created in the Attachments section with this Document Type pre-selected from the drop-down list.

· If the Document Type is set as Required, the Required icon is displayed next to the Description prompt and all the existing logic for required attachments is applied.
· If it's not required but set as [Display by Default] in Prequal Control then on page navigating and submission, a soft-warning message will remind users that they have not uploaded documents of this type and ask if they would like to return to the form before proceeding.
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Radio options have been added for ‘Self Service – Financial Attachments’ which allow the user to   select:

1. List Only

2. Required (Display by Default)

The Attachments section on Page 6 will display the default values (Rows can be added or removed as per requirement). Default value will be either the Attachment Type defined as Financial Attachments, if Financial Attachment checkbox is checked or [Other Attachments] default Type.
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Added row for each Display by Default Document Type.
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Added validation of required and display by default document types and to show warning messages or prevent form submission
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· Classifiers (Added in Assign Classifiers pop-up) have been added to SC Prequalification screen – References tab.

[image: image652.png](€)> ¢ @

@ Getting Started (@ Secret Server @) http://collab.cmic360....

© % % testovi2.cmic.ca:8888/cmictest12c/SdMenu/?appCode=VPQ

Subcontractor Prequalification

TESTV12ADF - ADF project for TESTV12. -

o 13

Code* SSVEND02 Tax ID*
Project: ADF project for TESTV12. (TESTV12ADf  Chmpany* Vendor 2 for SSC company
Also
4 Subcontractors KOS
PREQREQN N2g2! Vendor 2 for SSC company
SSVEND02 Parent
Corp.
Applicants ctrl
Business Q
Self Service Partner
Street 156 abc street Website

Subcontractor Rating Setup

g
O Locsions

Subcontractor Rating Questionnaire Setup

Prequalfications Control General User-Defined Fields Insurance
References
Workflow Notification
Company Name:
» Document Management
Street
» Maintenance
city
4 Security
Acknowledgement Date [::)
User Maintenance

% DnB Rating || 'O Reset Self-Service Password

SUBCONTRACTOR PREQ IFICATION =

1403

Prequalification
Status

Insurance
Category

Aggregate

Project Limit:

CAP Required

Host Region

Last Approval
Date

Update Prequal

300,000.00

Workflow ., st

Safety Financial Financial

State.

Surety

n o & o

8 Print Report Z @

8 Save

Insurance
Rating

s |
Status
Single

Project | 60,000.00
Limit:

cAP
Approved e

Urgent []

Renewal
=] Date =]

Prequal ,,

[} v

Litigation Submission Log ©

Approvals

Contact Name:
E-mail

zZip Phone

Action Code™

Applicant Number*

Role Maintenance

User Access

Subcontractor Reviews




Checklist Maintenance (Beta) – more enhancements (18.60270)
Action Item are now included in Checklist Maintenance (Beta) screen as shown below.
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Clicking on the ‘Calendar’ icon displays the Action Item pop-up, where the user can create new action items or can edit or delete the existing action items.
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Clicking on ‘Create New Assignment’ gives the screen to add new Action Item. 

A new feature ‘Kendo multicolumn combo box’ has been added for Urgency dropdown.
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A particular Action Item can be assigned to multiple contacts.
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User can create action items with or without recurrence and can Update them.
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After updating, the Calendar icon pop-up displays the list of all recurring and non-recurring Action Items.

User has the ability to Edit it by selecting it and to Delete it by clicking on Delete icon.
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The Action items (recurring / non-recurring) added in the Checklist maintenance screen appears on the Project Calendar screen.
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Checklist Maintenance (Beta) – Ongoing Enhancements (18.60270)
Following enhancements have been made in Checklist Maintenance (Beta) screen:

· A new PUSH functionality has been added for Global templates. It allows the user to assign the selected global templates to multiple projects.
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· COPY functionality has been added for both Global and Local Templates. User can copy one or multiple templates (Global or Local). 
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· DELETE functionality has been added for both Global and Local templates. User can delete one or multiple checklists (Global and Local).

{NOTE: The checklist templates that do not have any child records get deleted by clicking on Delete. And the templates with child records become Inactive when user click on [Delete] button. These Inactive templates then appear in the “Inactive” tab for that project checklist.}
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· Mass Archive functionality has been added for both Global and Local checklist templates. The archived records become inactive, and they appear in the ‘Inactive’ tab of the Checklist Template. 
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· Lock feature has been added to Project Checklist, after the Checklist record is Completed or Submitted.

· This feature is added to protect the data integrity of Submitted checklist records by restricting the users from editing project checklist templates once at least one record of the type has been saved/submitted (child record).

· Once child records have been created for a given Project Checklist Template – then clicking on ‘Edit’ button in such a template will display a modal dialogue (as shown in the screenshot):

[image: image671.png]€ > C A Notsecure | test2v12.cmic.ca:8888/cmictest12c/SdMenu/

Checklist Maintenance

Qe x* @s»0a2

€BackToLog |

ADFPROJ14 - Major poject ADF 14

CETS—

Punch List Status.

Punch List Item Description (by Pro}
FWD Status.

Notice Status

‘Submitial Type

Funding Source Maintenance
Contract Attemate Type Maintenanc
Csl Code Maintenance

Bid Package Type Maintenance
Bid Package Status

Weeldy Check List Maintenance
Checkist Schedule

WBS Codes

WBS Values

Checkist Maintenance.

Broadcast Messags Templates

*Template Name | New template to test Delete 1 0000000039
Created By Status
Created Date ‘Submitted Date.
Documents.

Drop files here to upload

[ s |«

{This Project; Gheclflisb
Template has,child

records;\Clickson [Edit]

[SES AV

B (section Title

Edit

Edit Header
'Drag & drop inputs from the toolb: der.





[image: image672.png]



· Click on [OK] in the dialogue box. User will be able to Edit the Project Checklist Template. Then click on [Save] and user will be presented with another modal dialogue:
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· When user click on [Save & Archive] in the popup:

· Then the original template becomes inactive.

· Modified version of template will be saved as a Copy.

· The Copy should inherit – Modified template configuration, Security settings, default issue contact and type, and all active assignments.
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· When user click on [Save as Copy] in the popup:

· Then the original template will remain as-is.

· The modified version will be saved as a copy.

· Copy process should be same as above, except that the active assignments will not get copied (to avoid duplication – since the original template will still be active).
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· New cloned section can now be deleted from Delete section menu in floating panel.
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Notes - Project Checklists

Current Delete Checklist Button in field security applies to the old functionality but will be modified to include the new Delete function currently under development.
Reviewer Email Notifications (19.71811)

Reviewer email notifications have been updated for Submittals and RFIs. The user contact must have ‘CC’ checked for Submittal and RFI in Project Contact Directory screen ‘Email Notifications’ tab. 
The following enhancement have been made:
· Non-mandatory reviewers receive email notification when they are added as reviewers.

· If a reviewer is mandatory (required) they receive notification when the previous mandatory reviewer has completed his action and they are the next responsible reviewer.
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SCCO: Modification of Item Code on SCCO When Linked to Posted PCI (21.41307)
New functionality has been added which allows the user to modify Item Code on Subcontract Change Order. The item code is created on a posted PCI’s detail line and carries forward when that PCI is linked to an unposted SCO. 

Points to keep in mind while testing:

The modified item code on the SCO will not update the Task code on the PCI.

Users cannot modify Item Code on posted SCO

A new security privilege has been added that controls whether a user can modify the item code on an unposted SCO, IN Security > Role Maintenance > Select role and assign privileges screen.
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Example:

1. Create a PCI with task code ‘PCI21.41307’ and post it.
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2. The posted PCI is added to an unposted subcontract change order (associated with the same SC used in the above PCI) using the [Add PCIs] button on the SCO screen. The item code is automatically populated with ‘PCI21.41307’ (carried forward from the PCI).

{NOTE:  Users can modify all fields (Item code, Unit, Rate, Amount, Long Description, Main Asset, Sub Asset, Cost Type, Document) of the SOV except for JOB/PHASE/CATEGORY/WM. The modified fields do not update the PCI. Users will be allowed to insert new lines in the SOV additionally to the ones transferred from the PCI.}
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3. In SCO screen, in edit mode – changed the item code from ‘PCI21.41307’ to ‘PCI-SCO-TEST-1’.  

             {NOTE: Only users with security privilege can modify the item code.}
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4. The modified item code in SCO screen does not update the PCI Detail line Task ID.
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Request for Documents (20.32911)
The Request for Documents program has been developed to extract project documents as part of Project Closeout procedures.
The program has been added under Document Management node in the tree-view.

 Access to it based on the user’s role and Assign Programs and Assign Menu Items privileges.
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Features of the Program:

{Precondition:

Upload a drawing and publish. The dates used in drawing upload will be used in Date type filter while creating the Request for Documents.}
· The user can create a Request by selecting different filters and parameters from the screen and schedule job which extracts the documents matching the filter criteria.
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A request can have different statuses and they are each outlined below.

[Pending]: As soon as user creates a new request, its status is marked as Pending. In this state user can Schedule or Cancel the request. 
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[Scheduled]: All pending requests can be Scheduled to start extraction process. As Schedule button is clicked the job scheduler creates a new job for this request and status would be changed to In Progress. 

{NOTE: The status may remain Scheduled as job scheduler (CmicScheduler) may take some time (few seconds) to start the job execution if it is available. If the job scheduler is not available, its status would remain Scheduled until job scheduler is available and picks up the job to extract documents.} 
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[In Progress]:  As soon as the document extraction job is started, an email is sent to the user saying, “Your request has been accepted and in progress”. User will be notified as it gets completed with download link.
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[Completed]: The document extraction process is completed, and user would receive email with the link to download the zip file of the documents. 

{NOTE:  The download link will be available for 14 days. If user hits the link in the email, it may not work as some extra characters being inserted by Outlook on the hyperlinks for security, in that case user may copy the link and paste into the new window on browser.}
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[Failed]:  There has been an error while job is executing, in this case user would receive an email for job failure.
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NOTE:  When user does not add appropriate data in the Request screen – user will receive the document extraction email followed by “No documents found” email.
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· User can edit existing Request parameters and save them back.

· The user can perform search by entering keyword in search box being provided on grid. e.g. "req-8". 
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· Filtering and Sorting options have been provided on the grid.
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· Three buttons have been added on Request logs:

[Create New Request for Documents]: User can create new requests and select parameters/filters to extract documents. 

​[Refresh Logs]: User can refresh the grid to view the latest of all Requests.

[Export to Excel]: To download all requests in xlxs file.
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A few enhancements have been made in RFD screen:

· RFD job has been modified to allow Null Status in request.
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· RFD job has been modified to allow multiple Created By users.
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· Field Security (Unrestricted and Read-Only) has been added on “Link Active Days” and “Downloads” fields.
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· Annotations added on the Drawing document will now be visible on the extracted document, after the Request has been Completed.

Steps followed:

· Uploaded a drawing in Drawing Management (ECM) and added an annotation to it.

· Published the annotation and linked a PM Object to it.

· Created a new Request to extract the uploaded Drawing document.

· Received email notifications for processing and download archive.

· Downloaded the archive from the link or button in the email.

· Opened the downloaded document.

· It displays the annotation that was added to the drawing document in Drawing Management.

· Click on the link – it opens the related object linked to the annotation.
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Location Added to Punch List Item Import (21.47354)
New functionality has been added in Punch List Items Import. A new column ‘Locations’ has been added in the .ctl file for importing Punch List Items. 

{NOTE:  The Locations can be added in File Maintenance > Local Tables > Locations Maintenance screen.}

In the Import pop-up user has an option to validate the values being imported. During the import process user will get an option to see the values and to add the new location code.

Example:
Click on [Import] button in the Punch Lists log screen.
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Select the file to be imported and click on [Upload].
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Validation screen appears. In this screen, select the values in Location field from the LOV and click [Re-Validate] and [Accept].
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Refresh the Punch List Items log screen and the imported items with Location code appear in the log screen.
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Open a record to verify if the ‘Location Code’ field displays the correct value.
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Punch List Items Trade Type Maintenance (21.48888)
A new column: ‘Description’ has been added in Trade Type Maintenance screen. User can drill down into this column’s value and can add multiple sub-descriptions to a particular Trade Type.
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Clicking on the description value link opens a small window to add and save sub descriptions.
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{NOTE:  For a Trade Type record, Description field value appears ‘0’ when no sub-description is added. This value changes based on the number of sub-descriptions added to it. E.g. if 2 sub-descriptions are added, ‘Description’ column will show ‘2’.}
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Show Related Annotation Documents (21.48954/PM-1760)
Enhanced the Related Objects pop-up to display both Related Objects and Documents. 

Additionally, some changes have been made in the Related Objects pop-up:

· [Assign Objects] button have been removed from the header bar

· Action icon (Delete) has been removed.

Outline
Open Documents > Drawing Management document type.
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Open an existing recently updated Drawing record or upload new drawing set for testing.
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In the record detail screen, click on the latest revision’s file name. It opens the drawing in PSPDF Viewer.
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Add annotations to the drawing and link them to PM Objects and Documents.
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After saving the annotations, click on the download icon for the same drawing to download its pdf.
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In the PDF, click on the annotation to which PM Objects were linked.
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Clicking on the annotation displays the Related Objects pop-up, in which all the PM Objects and Documents linked to the annotation appears.

{NOTE:  In the Related Objects pop-up, [Assign Objects] button and Delete Action icon have been removed.}
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Drawing Sheets Upload – More Extraction Enhancements (21.50002) 

An enhancement has been done in Drawing Upload screen to allow the user to adjust the size of the Extraction Region box.

The rectangle annotation resize grab handles have been enabled, which gives the user full control of adjusting the extraction region box’s size and placement.

When the user confirms the selection, the annotation gets locked, so that user can focus on next annotation.
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SC SOV Import – Modified to support WBS Codes (21.46108)
The SC SOV Import Schedule has been modified to support WBS Codes Import functionality on Subcontract SOV lines.  A new import file has been provided for the user which allows the user to import WBS Codes on Subcontract SOV.

Import file layout  (pmscsov.ctl)
fields terminated by "," optionally enclosed by '"'

  pmsovi_task_code         varchar2(16)

 ,pmsovi_task_name         varchar2(200)

 ,pmsovi_unit              number

 ,pmsovi_wm_code           varchar2(2)

 ,pmsovi_unit_rate         number

 ,pmsovi_amt               number

 ,pmsovi_job_code          varchar2(10)

 ,pmsovi_phs_code          varchar2(16)

 ,pmsovi_cat_code          varchar2(16)

 ,pmsovi_jb_bill_code      varchar2(50)

 ,pmsovi_tax1_code         varchar2(11)

 ,pmsovi_tax1_taxable_flag varchar2(1)    'Y/N'

 ,pmsovi_tax2_code         varchar2(11)

 ,pmsovi_tax2_taxable_flag varchar2(1)    'Y/N'

 ,pmsovi_tax3_code         varchar2(11)

 ,pmsovi_tax3_taxable_flag varchar2(1)    'Y/N'

 ,pmsovi_hldbk_pct         number

 ,pmsovi_apexp_code        varchar2(10)

 ,pmsovi_long_desc         varchar2(2000)

 ,pmsovi_wbsv_code1        varchar2(60)

 ,pmsovi_wbsv_code2        varchar2(60)

 ,pmsovi_wbsv_code3        varchar2(60)

 ,pmsovi_wbsv_code4        varchar2(60)
Import Process Outline
Opened an unposted subcontract.
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In Edit mode, clicked on [Import Schedule] button. SC SOV Import Schedule pop-up appears. Select the import .exe file and click on [Upload].
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The SC SOV Import Validation screen appears. In this screen review the error and warning messages and click on [Accept Valid].
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The SOV lines with WBS Codes are getting imported successfully.
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Submittal Logs – New Columns Added (20.33745)
The following new columns have been added in Submittal logs:

· Return Review Lead Time

· Return Review Start Date

· Return Review End Date

· Current Return Review Start Date

· Current Return Review End Date

· Record Status

The user can Add/Remove these columns with the Log Builder. 

Subcontract Change Order - Added GCS Pay Request Flag (19.86283)
Subcontract Change Order - Added GCS Pay Request flag to the screen to indicate that the change order can be processed through GCS for payment:
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IO Email Template Customizations (21.48278, PM-352)

A new look email has been designed for outbound I/Os.
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Cost Status Query Enhancement - Added PCI Description to PCI Transactions popup (21.44330)
Added PCI Description to the PCI pop-up window in the Cost Status Query and Budget Status Query (category and non-category).
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Contract Forecast – Added Group Code columns to Configure view and Forecast screen (21.42765)
An enhancement has been made in Contract Forecast screen. 5 Group Code columns have been added to the Configure View and Contract Forecast screens.
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When the ‘visible’ checkbox for all 5 Group Codes is checked in Configure view screen and [Save] is clicked; then the Forecast screen refreshes and displays the new added Group Code columns.
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Contract Forecast – Changed the Formula for Cost to Complete (21.51712)
The formula for ‘Cost to Complete’ in Contract Forecast has been changed.

Now, Cost to Complete (CTC) = Projected Cost Forecast – Spent/Committed (In scope).

{NOTE: This formula should work when the CTC is overridden; and when the overrides are cleared. The Cost to Complete column value should always reflect the subtraction of Project Cost Forecast and Spent/Committed (In scope)}
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Subcontract Prequalification – Added Currency field to 1st Financial tab of Subcontractor Prequal and Page 4 of Self Service Prequal (22.52898, CF-661, CF-662)
A new field “Currency” has been added to the 1st Financial tab of Subcontractor Prequalification and to Page 4 of Self Service Prequal (‘Financial Information’ section).
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Subcontractor Prequalification – Added Calculation for Single and Aggregate Award Limits (22.55253, CF-1060, CF-1076, CF-737)
A new flag “Default Project Limits Based on Working Capital Ratio” has been added to Prequalification Control screen.
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When this flag is checked (Y), then ‘Aggregate Project Limit’ and ‘Single Project Limit’ fields will default as 2x the value from the ‘Working Capital’ field (This field is in Financials tab – Contractor Prequalification screen).

These default values can be overridden by the user, who have access to the field.

The default values will get re-calculated (clearing any overrides) in case the Financial values are updated.

{NOTE: When an applicant submits their questionnaire the Single and Aggregate Project Limits would calculate as 2x working capital. This will be a one-time calculation per applicant, per renewal period.}
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PCI Entry – Added ‘Allow Cost’ flag to PCI header (21.38030)
A new flag 'Allow Cost' has been added to the PCI header in PCI Entry screen. This flag gets default value based on Allow Cost flag from relevant PCI Type on Maintain PCI Types setup. 

Field Security of ‘Unrestricted’, ‘Read-Only’ and ‘Hidden’ has been provided for the Allow Cost flag in PCI Entry screen. 
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The Allow Cost flag, on PCI Entry screen, gets default value from the PCI Type setup:
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{NOTE: The new flag is editable for the unposted and posted PCIs. When unchecked, the PCI does not appear for selection in cost transaction screens, MCT, Crew timesheets, Imaging, JC transaction, etc.}
When a PCI is created and is unposted, if the user changes the PCI Type, the ‘Allow Costs’ flag defaults the value for the updated PCI Type from the PCI Type setup screen in ADF.
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This flag is enabled for unposted and posted PCIs on PCI entry screen and can be updated when needed.

Unposted PCI:
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Posted PCI:
[image: image759.png]& > C A Notsecure | ga2vi2.cmic.ca8888/cmicptfR12/SdMenu/ Qe @s»0aa

Potential Change ltern [@save | (@ Cancel| | @ Bucbeamrevew| @ @
PCI Detai RFQ Review/Approval Notes. Related Objects Attachments History
Project: Major project 2 - End Year 2026 (ADF|
+Type Extemal PCI for Allow Cost « Description | Test Allow cost flag - unposted PCI ocono.| Q)
» Communication Management R
ommun agemen Status [APPROVED v Source Type | J
» Document Management [ Proceed | Forecast | || Allow Costs Reason | q
» Subcontractor Prequalfication * pate 00052022 Seoe P,
» B Management postone totsa Rosted|RCI source
4 Budget & Cost Management ‘Total Budgeted 1 200,00 | (] Update Projected During Posting
Subconact ToalBINg 5 50 g ) PrOSCISd ATIOUI 53 1ange ugget Amount
Subcontract Crange Orders
User Defined
Subcontacior SOV
‘Acknowledgement Date
Potental Change tms f Bl
Ouner Change Orders
Ouner Crange Transmital Key Dates N N
et . Start Date | | DueToOwner 5| ProposalIssued | 8] Changelssued | =]
auest For Faymen S——— B S S
Ena Date B Proposal Signed | ) Change Signed | B
Compiance Stats Log = .- .
Expense Authorization PCl Details
Costsiatus Query | showRates | Auto Calculate Markups
Budget Sttus Query print Curent  Curent_ orginal _ orginal
Acton | Sea | Descrption Warkup vendor Vendor Name | Subcontact o Phase: Catogory®  wdgeed  Budgeled | Budgeied  Budgeied Defaut Bil Code .
Cost Status Query (Category) ) e s L
Yengor 1or
utge it ey (Ctegoy) ARRIr IR i ssosscorot | o o 20 0 om ® [
company
Pl Projcton
ContractForecastng
T >
O Markun Rules.





When the Allow Cost flag is unchecked, the PCI will not show in LOV on relevant screens.

Below is an example from JC Cost Transaction Entry screen:

[image: image760.png]C A Notsecure | ga2v12.cmic.ca:8888/cmicptfR12/UIConsole/faces/console jspx Qe v EBs»0a2

CMIC ENTERPRISE PTFR12 O ssvewt ©

Enterprisev12 | Enterprise vi2Forms  ESS  E-Time  Enterprise R12

‘Search for programs. &

» General Ledger °
'+ Accounts Payable Enter Transactions. prit Edit List Post Transactions
» Accounts Receivable Selection Criteria
4 Job Costing * Company | ssC Q] (55 Construction Gompany Current period B
L om “Batch| 13209 Q| | New batch - Allow Cost fag testing -SS Starting (01052022 | Encing | 31.05.2022
etup
Create Batch
> Job
# Transactons Transaction
=== T T g Ve S S Y ST S ey e Yy —
Enter Bling Transaction
* Transaction 9883 | *PostDate (0905202 [
Enter Commited Cost Transaction * Journal [ 4G Q] [ sob Costing Trans Proof )
Process Recurring Entries Currency |USD Q] [us potar Conv Factor 1000000
Phase Quantty Completion source Source Desc
Reference Reference Desc:

» Accrual Processing

R, Date [08.05.2022 O Acorsl | Adjustment | Adjustment
» Forecasiing
> Lo
o Detail
> Query
Viewv Freeze ] Detach [ Search 4% Insert @ InsertMultiple % Delete O Workflows v & ReportOptions v [ Export v [ Import  ECMDocuments v % User Extensions

» Repors

“Type Company JobiDepUEGRMWO | CostCodelCompon/Aceh|  CatTranExp CrowCode | Quantiy Rate w Denit Credit WS Code 1 Name
> Utities

4 Q) ssc Q| |[sscsscoror Q| [os Q100 Q Q N Q] I Q
» Subcontract Management

» Change Management

Wiine Detail | | Create CostCodeiCat| | TAC| | Reference
4 Job Billing

> Setup




The relevant LOV is not showing the posted PCI because Allow Cost is unchecked for it, as shown in the previous screen shots.

{NOTE: In the Enter Cost Transaction screen – WBS Code column associated with PCI will become enabled only when user selects the phase and category for the Transaction detail line, same as the created PCI’s phase and category.}
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{NOTE: Value of ‘Allow Cost’ flag in PCI Setup entry screen will not impact the PCI’s availability in the relevant LOVs. For the example in above screenshot – the PCI will not be visible even when Allow Cost flag is checked on the PCI Type setup screen.}

Now, when Allow Cost flag is saved as checked on the PCI, this PCI becomes available in the cost transaction entry screen’s (and other relevant programs) LOV, irrespective of the setup’s flag value, as shown below.

[image: image762.png]<« C A Notsecure | qa2vi2.cmic.ca:8888/cmicptfR12/SdMenu/ Qe v E»0

Potential Change ltern @oaty Fo1 | (@A PCl

Copy || # Edit || & Print PCI || & Quick Print || 4 UnPost || % Link to Issue || % Uniink PC! Detail Line || @ Biuebeam Review | | ¢ Back To Log

ADFPROJ14 - Major project 2 - End Year 2021 ¥ | = PCl Detai RFQ Review/Approval Notes Related Objects  Attachments  History
O
S EXT-01
Project: Major project 2 - End Year 2026 (ADF ~
FR— o RS o

» Communication Management I
Status | APPROVED

Sourcoype

» Dosumentanagement P — Reason

» Subcontractor Prequalification * Date 00-05-2022 Days Impact

» Bid Management Post Date 09-05-2022 Source

+ unet . Costansgement Tt Budeted 155000 2 UpaateProjctedDurn posing
P— ToulBIINg 1 10009 PrORCISO RO g uset o

‘Subcontract Change Orders

User Defined

Subcontractor SOV
Acknowledgement Date
Potental Change tems.
Owner Change Orders
‘Owner Change Transmittal Key Dates
Start Date Due To Owner Proposal Issted Change Issued
Reauest For Payment
End Date Proposal Signed Change signed
Compiance Siatus Log
Expense Authorzation PCI Details
Cost Status Query ShowRates || Auto Calculate Markups
Budget Status Query print Curent  Curent  Oriinel  Original
Action Seq | Description Markup Vendor Vendor Name | Subcontract o Phase Category® | Bugetea Budgeted | Budgeted Budgetea DefaultBilCoce i
Cost Status Query (Category) O T e e
Vengor 1 for
Budget Status Query (Category) vl 1 wetas v | [ssvenbot || sSC ADFPR-$.002 ssesscorot o 1000 o | 121000 o oo
company
PGl Proection

Contract Forecasting




[image: image763.png]C A Nots

onsole/faces/console jspx

WBS Value List

4 Search

DESCRIPTION
AMOUNT

oRASEQ

DESCRIPTION

Test Alow cost .

ORASEQ

st7ser




If the Allow Cost flag is changed to unchecked in the relevant setup and saved, even then the PCI will continue to be available in the relevant cost transaction entry LOVs, unless the Allow Cost flag is changed to Unchecked on the PCI entry screen, as shown below:
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The setup’s Allow Cost flag is changed to Unchecked, but the PCI still shows in the cost transaction entry screen’s LOV:
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I/O Email - Added Option to Share Large Attachments via Download Link (22.54468/CF-228)
 

            The option to share large attachments with a download link is available when sending large       attachments via IO Email, instead of attaching the files to the email.
· Added new field prompt and checkbox “Share via download link” to IO Email pop-up
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· When checked- it includes a link(s) to download the selected attachments in the body of the IO Email. 
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· When unchecked - the IO email will be sent as a file(s) (no change)
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· Download links expiration date will be set based on Project System Options> Maximum Download Link Expiration (days) field. 
       Note: The Maximum Download Link Expiration (days) value must be an integer greater than or equal to 1.

· If “Maximum Download Link Expiration(days) is 1 or above
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· If “Maximum Download Link Expiration(days) is invalid
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Project System Options - Added a new drop-down list on General tab (22.55773)
· Added a new drop-down list on General page (Project System Options) for user to set up default issue priority.

· A tooltip in General page for default issue priority.

· Added a new column to default issue priority
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Submittal Package - Added Prepared By column (22.53671)
· Added an additional column in the Submittal multi-select LOV with the “Prepared By” partner organization displayed - to facilitate the selection of the intended submittals. 

· Search bar at the top of this LOV hits the “Prepared By” field when filtering - to allow users to search by the partner who prepared the submittal.
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Submittal - Added Procurement Log dates to Submittal Log (22.52604/CF-26)
Added Fabricated Date, Delivered Date and Arrived Onsite Date columns to the Log Builder for the Submittals object:
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RFIs - Schedule Impact & Cost Impact Fields to Default to the Value "NO" (21.52335/CF-137) 

RFIs - during the creation process - Schedule impact & Cost impact fields to default to the value "NO" 

User just need to change messages like below, in Prompt Maintenance:

pmscrfi.impact.option1.code = N
pmscrfi.impact.option1.desc = No
pmscrfi.impact.option2.code = P
pmscrfi.impact.option2.desc = Potentially
pmscrfi.impact.option3.code = Y
pmscrfi.impact.option3.desc = Yes
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Meeting Minutes - Confirmation Pop-up before Deleting Meeting Topic (21.51912/CF-122)
· Meeting Minutes Click “Delete” topic button, shows confirmation popups saying “The Meeting Topic will be deleted. Do you want to continue?”, click “OK”, the topic removed from the screen, after save, it is also removed from database. click “Cancel”, nothing changed in screen and database.
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Subcontracts - Field Security for Deposit Amount Remaining (21.50894)
Field Security to hide Deposit Amount Remaining has been added.
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Submittals - Response Block Brought Back for GC and Owner Modes (21.50200)
The Response block has been brought back to Submittal for both GC and Owner modes. It is controlled by field security (Un-restricted, Read-only, Hidden) with hidden as default.
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Submittal/RFI – Added Submitted, Returned, Closed Dates to Log (21.50071)

RFIs

· Added field to record [Date_Record_Closed]

· added field [Date_Record_Closed] to log builder for "Request For Information" log view

Submittals

· added field to record [Date_Record_Submitted] *New* related to custom

· added field to record [Date_Record_Closed]

· added field [Date_Record_Closed] to log builder for "Submittal" log view
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RFI - Option to Copy Related Objects to Forward RFI (21.45536)
Added "Copy Related Objects" option to Forward RFI popup window.
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· Add "Copy Related Objects" option to Update Ref. RFI popup window which is available for the forwarded RFI.

[image: image791.png]€ 5 C A Notsecur | test2vi.cmicca8888/cmictest12c/SdMenu/

Request for Information

Program soarch

Project: Majo project ADF 14 (ADFPROJTS)

4 Commnication Management
Project Calendar
My Actons
ystom Calondar
ProjoctPartner Ditactory
Project Contact Diectry
Distrution Lits
Masting Minsas.
Transmitats
Transmitals Queve

Communicatons

cuic BM %0

RFIDeta | Allachments  Reialed Objects v

‘ A ot submitted

History

% @ %02

SSRFI-64 ( Forwarded From SSRFI-63)

*From St Sl

Co Author [DaabasoAdnittor

|

*Subjet e * Crested Date 300322 Trpe
Satus [Ponding B Roauired 310322 Sous,
Cronges Resposaen. Ason Raymos
e @ Update References RFI Options -Google Chv.. — O X
‘m .4 A Not secure | test2v12.cmic.ca:8888/cmictest12c/PMSCR...
0 comtn
]
Sender

Receiver
1o Moo Ry
o
.

Rocaived

Last Update 300322 1113 A

Request





PCI Markup Rules - New Rounding Options; Removed References to Dollar (21.42130)

Maintain PCI Markup Rules screen will now include the following Rounding rule/options while setting up the markup rule:
· No Rounding

· Round to Nearest .01

· Round to Nearest 1

· Round to Nearest 10

· Round to Nearest 100

· Round to Nearest 1,000

· Round to Nearest 10,000

· Round to Nearest 100,000

· Round to Nearest 1,000,000
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PCI - Added Vendor Name Column to RFQ Tab (21.38805) 

Now Vendor Name also populates in the RFQ tab 
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Project Gateway Contact - Added Radio Button on Multi-user LOV to filter P Type users only (21.47711)
· Project Gateway Contact LOV -Added radio button on Multiuser LOV to filter P Type users only.
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Trade Maintenance – Modified Company Level prompts (22.54467)
Modified Title and Column names in Company level Trade Maintenance page. 

Below are the changes made : 

1. Trade Type Maintenance → Trade Maintenance

2. Type Code → Trade Stamp

3. Type Description → Trade Name

Restricted the Trade Stamp field up to 4 characters.
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File maintenance > Local Tables > Trade Maintenance
System Contact User Defaults – Added New Field Locale (Language) (22.53123)
New field Locale(Language) is added to System Contact User Defaults. The default language for prompts for the users can be defined in JSPs through this field.
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Documents - Locking/Unlocking mechanism (22.55559)
Modified the screens to Lock and Unlock the document and added drop zone based implementation for uploading the document. 

Added field security for Lock Button, Unlock Button, Checkin Button and Checkout button. Field Security has two options : Unrestricted and Hidden. 
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1. [Lock Document] 
This will only Lock the Document without Downloading the document.
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2. [Unlock Document]
This will unlock the document without checking in a document
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3. [Checkin Document]
This will bring up a pop-up as shown below, providing option to Unlock document and Check in/Upload a new revision .
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4. [Checkout Document] 
This will bring up a pop-up as shown below, providing option to Lock and Checkout/Download a document.
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Purchase Order

Unit Price added in Enter Job Receipt program (21.49621)

Unit Price added in the Enter Job Receipt program

Functionality Design:

In the PO Job Receipt program (POJOBREC) a new display column is added on detail level to show the Unit Price ( POS_EXPTD_PRICE_AMT ) from PO detail for the receiving item. There is no calculation, just display only.

By default, this field will be hidden, user will have to make this new field visible through lite editor.

Modification Details with Examples:
Through lite Editor User can add the new field ‘Expected Price’ and click on Save.
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The New field ‘Expected Price’ is visible now.
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Purchase Order Entry – Changes to Detail Entry & Save (22.57797)

PO Header to be Saved before entering PO Detail lines
Modifications:
· Purchase Order entry program is modified to use SAVE button before entering PO detail lines. 
· [Insert] and [Insert Multiple] toolbar button will only be visible when purchase order header is saved. 

Testing:
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Subcontract Management

New SC Lien Waiver (21.44416)

Added new SC Lien Waiver reports for Final and Partial.

Modifications:

Created a new Lien Waiver (SC_LIEN_WAIVER) with fields in the template:
1. Through_____: is the invoice date

2. To____: is the Company Name from Maintain Company 

3. Sum of $_____: Populated from the check date, check number, check amount,

4. Job: Job information from Maintain Job

5. Following described property: Populated from Maintain Project>Address Tab>Site Address

6. Lienor: Subcontract Name and address (same as existing template)

7. All the notary information: Blank

8. Dated On: Blank

Created a new parameter 'Print Report Version' with below 2 options:

1. VERSION1: Prints the current standard waivers.

2. VERSION2: Prints the new version reports.

Print the SC Lien waiver for the new version ‘Version2’.
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Control Contract Amount Field added in Modify Original Contract Program (21.51285) - Beta version

Warning: When the Control Contract Amount is populated in CMIC Field and posted, the clients will no longer be able to modify the SOV amounts via Modify Original Contract program in Enterprise.

Implementation is in progress and the fix will be available for next hotfix/patch release.
Overview:

A new field Control Contract amount is added to the Modify Original Contract screen

Modifications:
A field Control Contract Amount is added to the Modify Original Contract screen.
· The field is hidden by default, users may add this field via Lite Editor

· This defaults the value from Control Contract Amount of the base contract in CMIC Field.

· When a subcontract is modified via Modify Original Contract in ADF, the total amount of SOV should match the Control Contract Amount. If the total amount of SOV does not match the Control Contract Amount, users will not be allowed to proceed with an error message displayed. Users must fix the sum of SOV amounts to match the control contract amount.
Screenshots:
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If the total amount of SOV does not match the Control Contract Amount, error message is displayed at the time of posting.
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The following error message is shown at the time of posting
The sum of all amounts of SOV (2000.00) is not equal to the Contract Control Amount (1500.95)
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System Data

French and Spanish Translations – BETA Version (21.37298)
Overview

CMiC has released French and Spanish translations for ADF programs (UIRuntime, UIConsole, etc.). These two translations were released in patch 14-2 for Cloud and patch 15-1 for Enterprise customers.
The language pack was initially machine translated and we are in the process of reviewing its accuracy. Until we have completed this analysis, we will be publishing the language pack as BETA.
NOTE: Currently, not all screens support French and Spanish as display languages (e.g. JSP). 
Modifications
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Pgm: SDUPREF –User Preferences; standard Treeview path: System > Preferences > User Preferences
The User Preferences screen in the System Data module is used to define preferences for the selected user.
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Pop-up window launched from Default Local field
The Default Locale field is used to define the display language for ADF software screens (i.e. UIRuntime, UIConsole, etc.). By default, this field is set to "en_US" which displays ADF screens in US - English. With this enhancement, Spanish and French are now available as base languages, so local codes which start with the prefix "es_" (e.g. es_US, es_Spain, etc.) will display in Spanish and local codes which start with the prefix "fr_" (e.g. fr_Canada, fr_France, etc.) will display in French.
NOTE: As soon as 15-1 is installed, users whose Default Locale field is set to anything that starts with “es” and “fr” will see all the text on their screens translated to their language.
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User Settings pop-up window launched from console

The default display language can also be set in the User Settings pop-up window launched from the user’s console.
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Implementation
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Pgm: SDUPREF –User Preferences; standard Treeview path: System > Preferences > User Preferences
Open the User Preferences screen and click on the Default Locale field to launch the Local Code Lists pop-up window, which lists base languages and their associated country-specific variants. Select “fr_CA”, which will switch the default display language to "French - Canada" (i.e. the base language will be French and the locale will be Canada). Click [OK] to close the window. 
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Click [Save] on the console to save your changes. 
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Click the Refresh icon on the console and in the treeview to refresh the screen and update the default display language. 
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Example of Default Locale Set to French – Canada
The text in the treeview menu and the screen is displayed in French - Canada.
ComDataScheduler Job Frequency Update (21.48630)

[image: image822.png]SCHEDULER LOG

Selection Criteria

* Scheduler Name | ComDataScheduler v /| b Group [Comdata FTP

History Detail
viewy & Freeze ©, Workows v & ReportOptions v [ Export v Q) ECM Documents v s User Extensions
Date status Description Details Exception
e coneeE comenaesomoseanainesn _
Job start date: Tue Jan 18 10:15:00 EST 2022 =
18-an-2022 COMPLETED ‘Comdata file download and import Job end date: Tue Jan 1 10:15:00 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 10:10:00 EST 2022 =
18-Jan-2022 COMPLETED Gomdata fle dovnioad and import Job end date: Tue Jan 1 10:10:00 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 10.05:00 EST 2022 =
18-an-2022 COMPLETED ‘Comdata file download and import Job end date: Tue Jan 18 10:05:01 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 10.00:00 EST 2022 =
18-Jan-2022 COMPLETED Gomdata fle dovnioad and import Job end date: Tue Jan 18 10:00:01 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 09.55.00 EST 2022 =
18-an-2022 COMPLETED ‘Comdata file download and import Job end date: Tue Jan 18 09:55:01 EST 2022 -

Job state: COMPLETED Z




System Data > Utilities > Scheduler Log
The ComDataScheduler log displays the details of every run with Date/Time stamp. The default value is set at 60 minutes, which means it runs hourly. System Administrators/Database Managers may set the frequency to as low as 5 minutes to a maximum of 60 minutes as required.
Scheduler Log – COMDATA Scheduler Enhancement (22.52820)

The COMDATA Scheduler is now a standalone job dedicated for COMDATA processing to ensure uninterrupted running when other jobs such as Thumbnail Generator might interrupt due to high volume data.

This ensures COMDATA Scheduler run at pre-determined frequency un-interrupted so that payment processing happens as per schedule.
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System Data>Utilities>Scheduler Log >ComDataScheduler
[image: image824.png]SCHEDULER LOG

Selection Criteria

* Scheduler Name | CmicScheduler v | | sob Group [Thumbnail Generator

History Detail
viewy & Freeze Search  ©, Workows v & ReportOptions v [ Export v . ECMDocuments v s User Extensions
Date status Description Details Exception
Job start date: Tue Jan 18 13:46:49 EST 2022 =
18-Jan-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 18 13:46:52 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 13:46:49 EST 2022 =
18-an-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 18 13:46:52 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 13:33:49 EST 2022 =
18-Jan-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 1 13:33:50 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 1331:49 EST 2022 =
18-an-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 18 13:31:50 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 1321:49 EST 2022 =
18-Jan-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 1 13:21:50 EST 2022 -
Job state: COMPLETED 4
Job start date: Tue Jan 18 1321:49 EST 2022 =
18-an-2022 COMPLETED Thumbnail generation fo an attachment Job end date: Tue Jan 1 13:21:50 EST 2022 -

Job state: COMPLETED Z




System Data>Utilities>Scheduler Log >CMiCScheduler
COMDATA – Processing Improvements (19.84365-35/36)
COMDATA Processor is enhanced to skip any invalid files and continue to process the files in the folder and successfully import them into CMiC Check preparation program. The Comdata File folder on the server would have the invalid files left on the server, and users may review as required.
Tools

Export Queue (21.46306)
Overview

CMiC has developed a new Export Queue screen, which is a read-only log or program that displays information about exports, either launched from the toolbars or other programs and logs.

Pre-requisites

Add the new Export Queue screen (Pgm: SDEXPORTQUEUE) to the menu. The Target is called “SYS-Export Queue to call program SDEXPORTQUEUE”. We recommend adding it as a menu item under System Data > Utilities. 

After the screen has been added, export any file.

Modifications

Created a new screen called Export Queue (Pgm: SDEXPORTQUEUE) that can be added to the menu. This screen will provide the following information about file(s) being exported:

Session ID, user, module/application code, program that initiated the exported data, view/table name, number of exported rows, date and time export requested, date and time export started, date and time export completed, and status (PENDING, RUNNING, COMPLETED).

The export status messages are defined as follows:

· Pending: File export has been submitted but export has not started.

· Running: File export process has started.
· Completed: File export completed successfully.  
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Implementation

The following screenshots show how export information is displayed in the Export Queue screen when file exports are in process. In this example, two users are exporting employee profile details from their toolbar, so the Export Queue screen lists both users running the export file “DA.PY#EMPLOYEE_PROFILE”. 

In the first screenshot, the status for user “HADR12” is initially “PENDING”, and the status for user “ZohrehR12” is “RUNNING”.
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After the files are successfully exported, the status for both users changes to “COMPLETED”.
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